
ЛАБОРАТОРНА РОБОТА № 1 (модуль 2).
Асинхронні послідовні інтерфейси. Інтерфейс Я8-232С.

Тривалість: 2 акад. години (1 пара).
Мета: ознайомлення з принципами роботи аиснхронного послідовного

інтерфейсу Я8-232С.

Лабораторна установка.
Лабораторна робота виконується робочих місцях 2-5, 7-10. 
Апаратне забезпечення. Схема установки показана на рис.1.1.

Програмне забезпечення. Використовується прикладна програма для 
сканування і запису СОМ-порта комп’ютера Compt.exe.

Загальна постановка задачі. З’єднання між двома ПК по Я8-232 проводиться 
з використанням нуль-модемного кабелю. У лабораторній роботі можна використати 
як повний так і мінімальний нуль-модемний кабель.

УВАГА! СОМ-порти ПК не ізольовані, тому для безпечного з’єднання необхідно підключати 
нуль-модемний кабель при вимкненому ПК, з дозволу викладача.

Послідовність виконання роботи.
1) Зібрати лабораторну установку. Запустити на виконання програму Compt.exe

на РС1 та РС2. Ознайомитись з її роботою (див. додаток 1).
2) Налаштувати РС1 та РС2 на роботу з наступними параметрами :

робочі місця
2,3 4,5 7,8 9,10

Бітова швидкість (біт/с) 9600 9600 9600 9600
кількість бітів данних 8 8 8 8
паритет парний непарний парний відсутній
кількість стопових біт 1 2 1 2

3) 3. РС1 на РС2 передати наступні символи (в 16-ковому форматі):
робочі місця

2,3 4,5 7,8 9,10
08, ББ 02, БЕ 14, Е1 АА, ВВ

4) Нарисувати часову діаграму стану сигналу на лінії як на рис.1.2 в масштабі: 1 
клітинка = 1/19200 с. Нарисувати діаграму з поясненням інтерпретації сигналу 
приймачем РС2 при бітовій швидкості 9600 біт/с.

3



стан лінії зв'язку

к інтерпретац ія прийм ачем  при б ітовій ш видкості 9600 біт/сі—о.(О1—о
0 0 0 1 1 0 1 1 І—0)1-О.

1=о1—о
1—о.го1—о

1 1 0 0 0 1 0 0 1—О)1-О-
1=о1—о

передача,

4--
біти дани х

1=

— 4--
б ти да них

1=

—̂

і
в ід с у тн я '

1- й симівол 2-й с имвс)Л

1/9600 с

інтерпретац ія  прийм ачем  при б ітовій ш видкості 19200 біт/с

Віти даних

1/19200 Ь

біти ДаниХ

1 1 1 1 0 0 0 0

біти да ни ( \N  ! і У

Зага;Р

0

біти Даних

Рис.1.2. Діаграми стану лінії та інтерпретація приймачем сигналу на бітовій 
швидкості 9600 на прикладі передачі двох символів: 1-й -  11011000; 2-й -  
00100011. Біт паритету -  непарний; 1 стоповий біт.
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5) Змінити бітову швидкість на РС2 з 9600 на 19200 біт/с. Повторити крок 3. 
Нарисувати діаграму з поясненням інтерпретації сигналу приймачем РС2 при 
бітовій швидкості 19200 біт/с. (рис.1.2.).

Оформлення роботи.

До захисту готовиться рисунок з інтерпретацією сигналу приймачем при 9600 
біт/с та 19200 біт/с.

Перевірка виконання роботи та питання до захисту.
Викладачем перевіряється виконання поставленого завдання. Студент повинен 

пояснити отримані результати, коментуючи діаграми з інтерпретаціями.

1. Яке призначення контактів 9-пінового роз’єму для реалізації Я8-232С?
2. Які основні контакти використовуються при нуль-модемному з’єднанні без 

синхронізуючих сигналів?
3. Чим відрізняється повний та мінімальний нуль-модемний кабель?
4. Навіщо необхідні стартовий та стопові біти при символьній асинхронній 

передачі?
5. Роз’ясніть призначення біту паритету.
6. Роз’ясніть чому саме такі дані отримав РС2 на основі діаграми з кроку 4 та 

порівнянні відправлених і отриманих даних.
7. Що значить симетричний спосіб передачі по напрузі? Чим він краще за 

асиметричний?
8. Скільки провідників необхідно для реалізації з’єднання пристроїв по 

інтерфейсу ЯБ-485 при напівдуплексному зв’язку?
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9. Яка принципова відмінність між Я8-422 та К8-485?
10. Навіщо використовується захисне зміщення в мережах на базі Я8-485?
11. Навіщо потрібні термінатори лінії я які як правило їх номінали для Я8-422 та 

Я8-485?
12.Чим викликана необхідність в управлінні станом передавача адаптера- 

перетворювача інтерфейсів Я8-232 -  Я8-485. Які схеми реалізації адаптерів Ви 
знаєте?

Додаток 1.1. Робота з програмою Compt.

Д1.1.1. Загальні відомості. Дана програма являється утилітою для роботи з 
COM-портами комп’ютера. Серед її можливостей треба виділити наступні:

-  відправляти/приймати послідовність символів представлені в 16-ковому або 
символьному форматі;

-  налаштування COM-порту на різні параметри передачі/прийому;
-  управляти потоком даних сигналами RTS та DTR в ручному режимі
Після завантаження, як правило видається помилка доступу до COM-порту, на 

яку не слід зважати.
УВАГА! Будь-які дві програми не можуть використовувати один і той же COM-порт 
одночасно (за певними винятками). Тому перед використанням Compt.exe необхідно закрити 
всі програми, які доступаються до COM1.

Д 1.1.2. Основні команди. Якщо програма завантажилась в англомовному 
варіанті, перейдіть на російськомовний: Options->Language->Russian .

Настройка COM-порту: Настройка->СОМ-порт
Набрати і відправити послідовність символів: Сообщение->Отправить
Управління сигналом RTS відбувається за допомогою відповідних кнопок на 

панелі інструментів: кнопка вверх -  увімкнути, кнопка вниз -  вимкнути.
Як тільки програма завантажена і налаштований порт, вона прослуховує його і у 

випадку появи символів, записує їх у вікно "Принято".
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ЛАБОРАТОРНА РОБОТА № 2(модуль 2).
Формування запитів MODBUS RTU.

Тривалість: 2 акад. години (1 пара).
Мета: ознайомитись з принципами функціонування протоколу MODBUS; 

ознайомитись з роботою адаптера-перетворювача інтерфейсів RS-232<->RS-485.

Лабораторна установка.
Лабораторна робота виконується на робочих місцях 2-5, 7-10. Одна бригада -  

два робочі місця.
Апаратне забезпечення. Лабораторна установка складається з комп’ютера 

підключеного до термінального порту ПЛК Twido за допомогою адаптера- 
перетворювача інтерфейсів RS-232 <-> RS-485. Схема установки показана на рис.2.1.

Програмне забезпечення. На комп’ютері використовується 
прикладна програма для роботи з COM-портом комп’ютера 
Compt.exe, а також програма для генерації циклічного 
перевірочного коду CRC 16 -  crcdll.exe (знаходиться в папці 
Compt175). На ПЛК написана програма, яка змінює значення 
змінних відповідно до варіанту. З’єднання ПЛК та ПК 
реалізується за допомогою Modbus RTU, де ПЛК являється Slave, 
а ПК разом з Compt.exe являється Master.

Загальна постановка задачі. Лабораторна бригада 
реалізовує роботу MODBUS RTU Master, тобто формує запити для Slave (ПЛК) та 
обробляє його відповіді. Основні функції, можливі помилки та їх коди наведені в 
додатках 2.1 та 2.2. Контрольну суму необхідно вираховувати за допомогою 
програми crcdll.exe, яка в аргументах приймає байти кадру в 16-ковому вигляді, які 
розділені " " (пробілом), а результатом видає 2 байти суми CRC16.

Необхідно врахувати особливості роботи кабелю TSX PCX 1031 та його вплив 
на роботу Port1 в Twido. Принципи функціонування кабелю описана в додатку 2.3.

Послідовність виконання роботи.

1) Зібрати лабораторну установку. Запустити на виконання програму Compt.exe 
на РС.

УВАГА! Porti ПЛК Twido і COM-порт ПК не ізольовані, тому для безпечного з’єднання 
необхідно підключати перетворювачі при вимкнених ПЛК, з дозволу викладача.

ПЛК 
Port1

TSX PCX10:

сом1

PC

Рис.2.1.

2) Налаштувати COM-порт на роботу з наступними параметрами :
Параметр робоче місце

2 3 4 5 7 8 9 10
Адреса Slave 2 3 4 5 7 8 9 10
бітова швидкість 19200 19200 19200 19200 9600 9600 9600 9600
паритет парн парн парн парн непар непар непар непар
стоп біт 1 1 1 1 1 1 1 1
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3) Виставити кабель в необхідне положення: Porti Twido працює в режимі 
визначеному конфігурацією; перетворювач управляється зі сторони RS-485.
4) Сформувати та занотувати запит на читання у Slave 3-х внутрішніх регістрів
(%MW), починаючи з вказаного (приведений в таблиці нижче в десятковому 
форматі)_________________________________________________

Параметр робоче місце
2 3 4 5 7 8 9 10

номер
регістру 12310 6810 3410 17610 3410 1110 6710 9510

5) По сформованому в п.4 запиту визначити контрольну суму CRC16 за 
допомогою програми crcdll.exe. Занотувати повний формат кадру разом з 
отриманим CRC16.
6) Відправити кадр, визначений в п.5. по мережі за допомогою Compt.exe. 
Отриману відповідь занотувати. Значення змінних перевести в десятковий 
формат та занотувати.
7) Перевірити, чи вірно отримані дані по стану поля CRC 16. Результат 
проаналізувати та занотувати.
8) Відправити той самий запит, що у пункті 6, але при іншому біті паритету 
(якщо був парний -  то при непарному і навпаки). Отриманий результат 
проаналізувати і занотувати.
9) Відправити запит на читання 3-х регістрів, починаючи з 10001о . Отриманий 
результат проаналізувати і занотувати.
10) Сформувати запит на запис Slave 2-х внутрішніх регістрів, починаючи з 
вказаного (приведений в таблиці нижче в десятковому форматі). Визначити 
контрольну суму CRC16 за допомогою програми crcdll.exe. Занотувати формат 
кадру і відправити по мережі. Отриману відповідь проаналізувати та 
занотувати.

Параметр робоче місце
2 3 4 5 7 8 9 10

номер
регістру 210 310 410 510 710 810 910 1010
знач. 
регістр 1 3410 2210 4410 5610 оООSO 1210 1410 оООSO

знач. 
регістр 2 234510 123410 345610 456710 567810 911210 112310 765410

Оформлення роботи.
До захисту готовляться всі занотовані результати з поясненнями.

Перевірка виконання роботи та питання до захисту.
Викладачем вибірково перевіряється виконання всіх пунктів роботи та 

занотовані результати. Кожен результат студент повинен пояснити. У випадку 
виникнення помилок або запитань щодо проведення певного пункту, цей пункт 
необхідно буде повторити.

1. Розкажіть про основи функціонування MODBUS Application Protocol. Який 
формат повідомлення MODBUS PDU?
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2. Які функції використовуються для доступу до даних процесу?
3. Як формуються повідомлення-запити та повідомлення відповіді для читання 

та запису діапазону вхідних та вихідних регістрів?
4. Які ситуації можливі при обробці запиту MODBUS Клієнта? Наведіть 

приклади відповідей про помилку.
5. Прокоментуйте основи функціонування MODBUS RTU/ASCII в контексті 

моделі OSI. Як пов’язана модель функціонування обміну на прикладному 
рівні з функціонуванням на канальному?

6. Який метод доступу до шини використовується в MODBUS RTU/ASCII на 
канальному рівні? Як на цьому рівні проводиться контроль за правильністю 
доставки бітової послідовності?

7. Поясніть призначення поля адреси. Чому виникає необхідність в адресації? 
Чи використовується поле адреси при з’єднані точка-точка в MODBUS RTU?

8. В чому відмінність роботи MODBUS RTU та MODBUS ASCII на канальному 
та фізичному рівні?

9. Розкажіть про принципи побудови кадрів для MODBUS RTU та MODBUS 
ASCII.

10. Які інтерфейси, бітова швидкість та топологія використовується для 
MODBUS RTU/ASCII на фізичному рівні? Яким чином вузли можуть 
підключатися до загальної шини?

11.Чим викликана необхідність в управлінні станом передавача адаптера- 
перетворювача інтерфейсів RS-232 <-> RS-485.

12.Якими способами може управлятись стан передавача адаптеру TSX PCX 
1031? Як задати кожний із режимів? Коли використовується кожний із них?

Додаток 2.1. Формат функцій MODBUS (MBAP)

Повний список кодів а також специфікацію протоколу можна знайти на 
офіційному Веб сайті MODBUS-IDA - www.MODBUS.org. В додатку детально 
розглянуто тільки найбільш вживані функції MODBUS для обміну даними процесу. 
Номер функції дається в шістнадцятковому форматі. Скорочення в дужках Hi та Lo 
вказують відповідно на старший та молодший байти. Тобто, якщо для вказівки 
адреси початкової змінної необхідно двобайтове слово, то значення старшого байта 
буде передаватись в полі з позначенням Hi, а молодшого -  відповідно Lo.

Д.2.1.1. Код функції 0116 -  читання статусу Coils (дискретних вихідних 
бітів). Повідомлення-запит вміщує адресу початкового біту і кількість бітів для 
читання. Біти нумеруються починаючи з 0. У повідомленні-відповіді кожне значення 
змінної передається одним бітом, тобто в одному байті пакується статус 8 бітових 
змінних. Якщо кількість їх не кратно восьми, інші біти в байті заповнюються 
нулями. Лічильник вміщує кількість байт в полі даних.
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Запит: Відповідь:
Код функції 01

Адреса початкового біту (Ш) 0 до FFFF16
Адреса початкового біту (LO)

Кількість біт (Ш) 1 до 7D0l6 
(2000)Кількість біт (LO)

код функції 01
лічильник байт N

Значення бітів (перші 8 біт) 0 до FFl6
Значення бітів (наступні 8 біт) 0 до FFl6

Значення бітів ^ -н і 8 біт) 0 до FFl6

Д.2.1.2. Код функції 02іб -  читання статусу дискретних входів. Формат даного 
запиту такий же як попереднього, за винятком поля функції.

Д.2.1.3. Код функції 0316 -  читання значення вихідних/внутрішніх регістрів.
Повідомлення-запит вміщує адресу початкового вихідного/внутрішнього регістру 
(двохбайтове слово), і кількість регістрів для читання. Регістри нумеруються 
починаючи з 0.

Запит: Відповідь:
код функції 03

Адреса початкового регістру (№) від 0 до 
FFFF16Адреса початкового регістру ^ )

Кількість регістрів (Ш) від 1 до 
7Dl6 (125)Кількість регістрів (Lo)

код функції 01
лічильник байт N*2

Значення 1-го регістру (№) 0 до 
FFFF16Значення 1-го регістру ( ^ )

Значення ^ г о  регістру (Ш) 0 до 
FFFF16Значення ^ г о  регістру (Lo)

У відповідному повідомленні в полі даних кожний регістр передається двома 
байтами.

Д.2.1.4. Код функції 04іб -  читання значення вхідних регістрів. Формат 
даного запиту такий же як попереднього, за винятком поля функції.

Д.2.1.5. Код функції 0Р16 -  запис декількох вихідних/внутрішніх бітів. В
запиті вказується початкова адреса біту, кількість біт для запису, лічильник байтів і 
безпосередньо значення. В широкомовній передачі біти записуються всім серверам. 
Розглянемо приклад для встановлення наступних бітових вихідних/внутрішніх 
змінних:

Байт 1 Байт 2
26 25 24 23 22 21 20 19 28 27
1 1 0 0 1 1 0 1 0 1

В таблиці показана відповідність адреси змінної, починаючи з 19-ї, і значення 
біту. Для зручності біти розміщені у тому порядку, що і передаються. В другому 
байті корисні тільки 2 перші біти, значення інших не буде прийнято до уваги, 
оскільки кількість бітів вказані у кадрі. Запит та відповідь будуть мати такий вигляд:

Запит:
Функція 0F

Адреса початкового біту (№) 00
Адреса початкового біту (Lo) 13

Кількість бітів (Ш) 00
Кількість бітів (Lo) 0А
Лічильник байтів 02
Дані(змінні 19-26) CD
Дані(змінні 27-28) 01

Відповідь:
Функція 0F

Адреса початкового біту (№) 00
Адреса початкового біту (Lo) 13

Кількість бітів (Ш) 00
Кількість бітів (Lo) 0А
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Д.2.1.6. Код функції 10іб -  запис декількох вихідних/внутрішніх регістрів.
Запит:

Функція 10іб
Адреса початкового регістру (Ні) 0 до 

FFFF16Адреса початкового регістру (Ьо)
Кількість регістрів (Ні) 1 до

007B16 (123)Кількість регістрів (Ьо)
Лічильник байтів 2*N

Дані (1-й регістр Ні) 0 до 
FFFF16Дані (1-й регістр Ьо)

Дані (Н-й регістр Ні) 0 до 
FFFF16Дані (Н-й регістр Ьо)

Відповідь:
Функція 10

Адреса початкового регістру (Ні) 0 до FFFF16
Адреса початкового регістру Ьо

Кількість регістрів (Ні) 1 до 007B16 
(123)Кількість регістрів (Ьо)

Додаток 2.2. Повідомлення про помилки MODBUS (MBAP)
Ці повідомлення стосуються всіх типів MODBUS, але першопочатково були 

визначені для MODBUS Serial (RTU/ASCII).
При запиті Клієнта до Серверу, можуть мати місце наступні ситуації:

-  якщо Сервер прийняв запит без комунікаційних помилок, і може нормально
розпізнати запит, він повертає нормальну відповідь;

-  якщо Сервер не прийняв запит, відповідь не повертається. Клієнт очікує відповіді 
протягом певного тайм-ауту;

-  якщо Ведений (для MODBUS Serial) прийняв кадр, але знайшов комунікаційну 
помилку (паритет, помилка контрольної суми), то кадр-відповідь не повертається, 
а Ведучий чекає відповіді на запит протягом певного тайм-ауту;

-  якщо Сервер прийняв запит без комунікаційної помилки, але не може виконати 
замовлену функцію (наприклад, читання не існуючих виходів або регістрів), 
Сервер повертає повідомлення про помилку і її причини.

Таблиця Д2.1
Список кодів помилок

Код Назва Опис
01 ILLEGAL

FUNCTION
Прийнятий код функції не може бути оброблений на 
Сервері

02 ILLEGAL DATA 
ADDRESS Адреса даних вказана в запиті не доступна даному Серверу .

03 ILLEGAL DATA 
VALUE

Величина, вміщена в полі даних запиту являється не 
допустимою величиною для Серверу .

04 SLAVE DEVICE 
FAILURE

Невиправна помилка мала місце поки Сервер намагався 
виконати дію запиту.

05 ACKNOWLEDGE
Сервер прийняв запит і обробляє його, але необхідний 
певний час. Ця відповідь захищає Клієнта від генерації 
помилки тайм-ауту.

06 SLAVE DEVICE 
BUSY

Сервер зайнятий обробкою команди, Клієнт повинен 
повторити запит пізніше.

07 NEGATIVE
ACKNOWLEDGE Невдалий програмний запит (для функцій 13 і 14).

08 MEMORY 
PARITY ERROR

Сервер хоче читати розширену пам’ять, але знайшов 
помилку паритету.

Повідомлення про помилку має два поля які відрізняються від полів 
нормальної відповіді:
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ПОЛЕ КОДУ ФУНКЦІЇ: при нормальній відповіді сервер повертає в цьому 
полі той номер функції, який потребував Клієнт. У всіх кодах функції старший біт 
встановлений в 0. При поверненні повідомлень про помилку, Сервер встановлює 
цей біт в 1, по чому Клієнт може ідентифікувати наявність помилки.

ПОЛЕ ДАНИХ: В цьому полі при помилці повертається її код.

Додаток 2.3. Робота адаптеру перетворювача TSX PCX 1031

Адаптер-перетворювач TSX PCX 1031 (див.рис.2.2) використовується для 
підключення пристроїв з RS-232C до термінального порту TSX Twido, TSX Micro, 
TSX Premium, або коробки підключення TSX P ACC01. Управління станом 
трансмітера RS-485 в адаптері-перетворювачі може управлятись одним із двох 
способів, які задаються перемикачем: зі сторони RS-232C сигналом RTS (позиція 
"MULTI"), або зі сторони термінального порту ПЛК (позиція "DIRECT"). Оскільки в 
стандарті RS-485 немає виділених ресурсів для режиму DIRECT, то він 
використовується тільки для підключення адаптера безпосередньо до термінального 
порту ПЛК , тобто у випадку з’єднання точка-точка.

TER/OTHER MULTI TER/OTHER DIRECT

Рис.2.2. Режими роботи адаптера 
перетворювача RS-232<->RS-485 TSX PCX

Враховуючи, що TSX PCX 1031 використовується в якості кабелю 
програмування вищезазначених контролерів, він надає можливість переводити 
підключений термінальний порт ПЛК в режим програмування. Перемикач кабелю в 
позиції "TER" переводить підключений порт ПЛК в режим програмування, не 
залежно від дійсної його конфігурації. Позиція "OTHER" переводить термінальний 
порт в той режим, який визначається його дійсною конфігурацією.
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ЛАБОРАТОРНА РОБОТА № 3 (модуль 2).

Використання шини MODBUS RTU для зв’язку SCADA програм з ПЛК.

ЧАСТИНА 1.

Тривалість: 1 акад. година (0.5 пари).
Мета: Навчитись створювати конфігурацію SCADA-програм для роботи з 

мережами, основаними на асинхронних послідовних інтерфейсах на прикладі 
MODBUS RTU і SCADA VijeoCitect в режимі точка-точка.

Лабораторна установка.

р

ПЛК

ort.1

Лабораторна робота виконується на робочих місцях 2-5, 7-10. Одна бригада -  
два робочі місця.

Апаратне забезпечення. Лабораторна установка 
складається з комп’ютера підключеного до термінального порту 
ПЛК Twido за допомогою адаптера-перетворювача інтерфейсів 
RS-232 <-> RS-485. Схема установки показана на рис.3.1. TSX PCX1031

Програмне забезпечення. На комп’ютері 
використовується SCADA-програма VijeoCitect. На ПЛК сом1
написана програма, яка змінює значення змінних відповідно до PC

варіанту. З’єднання ПЛК та ПК реалізується за допомогою Рис.3.1.

MODBUS RTU, де ПЛК являється Slave, а драйвер для I/O 
Server VijeoCitect являється Master.

Загальна постановка задачі. Ціль роботи -  реалізувати поставлену задачу, 
оформлену у вигляді схеми інформаційних потоків. Ця задача передбачає обмін 
даними між SCADA програмою VijeoCitect (вірніше його I/O Server) та TSX Twido.

У лабораторній роботі використовується класичний підхід, де SCADA являється 
Клієнтом, тобто ініціює обмін. Для MODBUS RTU Клієнт завжди виконується на 
вузлі з правами Ведучого, тому драйвер MODBUS RTU для VijeoCitect повинен 
реалізовувати протокол MODBUS Master. Налаштування I/O Server та драйверів 
MODBUS в інструментальному середовищі VijeoCitect описані в додатку 3.1.

Для такого з’єднання адаптер-перетворювач може працювати в режимі 
управління трансмітером з боку контролера .

УВАГА! Термінальний порт ПЛК і СОМ-порт ПК не ізольовані, тому для безпечного 
з’єднання необхідно підключати перетворювачі при вимкнених ПЛК, з дозволу викладача.

Деталізований опис постановки задачі. В лабораторній роботі необхідно 
реалізувати задачу, показану на схемі інформаційних потоків (рис.3.2).
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порт Slave

Рис.3.2. Схема інформаційних потоків до частини 1 лабораторної роботи №3.

Коротка характеристика інформаційних потоків (за номерами):
1) Клієнтською стороною для цього потоку (так як і для інших двох) є SCADA, 

отже умовно можна сказати, що починається він саме з IOServerl. Даний потік 
реалізовує зчитування даних для змінних Varl, Var2, Var3 1 раз/5с. Для Varl 
джерелом буде W1 (вибирається відповідно до варіанту), для Var2 - W2, Var3 - W3. 
Реалізується потік сервісом MODBUS запитів (у MODBUS RTU інших сервісів не 
існує). Продовження потоку йде через термінальний порт Port1 ПЛК. На цьому 
портові ПЛК являється MODBUS Slave з адресою 1 (залежить від робочого місця). 
Потік закінчується змінними, з вказівкою серверної частини потоку (круг).

2) Другий потік повинен реалізувати запис вихідного значення змінної Var4 в 
змінну W3, при його зміні в Citect.

3) Третій потік повинен реалізувати запис вихідного значення змінної Var5 в 
W4, при зміні його значення в Citect.

Послідовність виконання роботи.

1) Зібрати лабораторну установку.

УВАГА! Porti ПЛК Twido і COM-порт ПК не ізольовані, тому для безпечного з’єднання 
необхідно підключати перетворювачі при вимкнених ПЛК, з дозволу викладача.

2) Завантажити Vijeo Citect Explorer. Створити I/O Server, Board, Port, Device та 
VariableTags відповідно до завдання (схема інформаційних потоків) та наступної 
таблиці:
Параметр робоче місце

2 3 4 5 7 8 9 10
Адреса Slave 2 3 4 5 7 8 9 10
бітова швидкість 19200 19200 19200 19200 9600 9600 9600 9600
паритет парн парн парн парн непар непар непар непар
стоп біт 1 1 1 1 1 1 1 1
адреса регістру W1 123 68 34 176 34 11 67 95
адреса регістру W2 124 69 35 177 35 12 68 96
адреса регістру W3 125 70 36 178 36 13 69 97
адреса регістру W4 2 3 4 5 7 8 9 10
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3) В Graphics Builder створити сторінку з елементами для відображення (Varl, Var2, 
Var3) та вводу змінних (Var4, Var5).
4) Запустити виконавчу систему Vijeo Citect, попередньо налаштувавши правильні 
параметри запуску (Tools-> Computer Setup Wizard). Оцінити орієнтовну швидкість 
відновлення змінних, та занотувати.
5) Активізувати кеш та змінити час відновлення кешу на 5 с. Перезапустити 
виконавчу систему, оцінити орієнтовну швидкість відновлення змінної та 
занотувати.

Оформлення роботи.
До захисту готовляться всі занотовані результати з поясненнями.

Перевірка виконання роботи та питання до захисту.
Викладачем вибірково перевіряється виконання всіх пунктів роботи та 

занотовані результати. Кожен результат студент повинен пояснити. У випадку 
виникнення помилок або запитань щодо проведення певного пункту, цей пункт 
необхідно буде повторити.

1. Ким як правило є база даних реального часу SCADA при з’єднанні її з 
контролером по MODBUS RTU: клієнтом чи сервером? Скільки клієнтських 
та серверних прикладних процесів може функціонувати в одній мережі 
MODBUS RTU?

2. Яким чином на схемі можуть показуватися клієнтські та серверні частини 
інформаційних потоків? Покажіть та прокоментуйте шлях всіх потоків на 
робочій схемі до лабораторної роботи .

3. Розкажіть про відмінність в реалізації адресного простору серверів 
MODBUS.

ЧАСТИНА 2.
Тривалість: 1 акад.година (0.5 пари).
Мета: Навчитись створювати конфігурацію SCADA для роботи з MODBUS 

RTU в шинних топологіях; отримати навички аналізу мережного обміну з 
використанням програм сканерів.

Лабораторна установка.
Лабораторна робота виконується на робочих місцях 7-9. В ній одночасно 

приймають участь студенти всіх бригад підгрупи.
Апаратне забезпечення. Схема установки показана на рис.3.3.
ПЛК7, ПЛК8, ПЛК9 -  контролери Twido LMDA20DTK.
КП1, КП2, КПЗ -  коробка підключення TSX P ACC01.
Програмне забезпечення. На комп’ютері РС8 використовується SCADA- 

програма VijeoCitect, на РС7 та РС9 програма-сканер СОМ-порта compt.exe. 
З’єднання ПЛК та РС7 реалізується за допомогою MODBUS RTU, де ПЛК 7,8,9 
являються Slave, а драйвер для I/O Server VijeoCitect являється Master.

Загальна постановка задачі. Ціль роботи -  реалізувати поставлену задачу, 
оформлену у вигляді схеми інформаційних потоків, та за допомогою програми- 
сканера проаналізувати роботу мережі. Ця задача передбачає обмін даними між 
SCADA програмою VijeoCitect (вірніше його I/O Server) та декількома TSX Twido.
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У лабораторній роботі SCADA являється Клієнтом, тому драйвер MODBUS 
RTU для VijeoCitect повинен реалізовувати протокол MODBUS Master. ПЛК 
являються Веденими.

Враховуючи мультиточкове з’єднання через спеціальні коробки TSX P ACC01, 
адаптер-перетворювач повинен працювати в режимі управління трансмітером з боку 
RS-232 (див. Додаток 3.2). Крім того, необхідно вірно налаштувати опції VijeoCitect, 
для управління сигналом RTS.

УВАГА! Термінальний порт ПЛК і COM-порт ПК не ізольовані, тому для безпечного 
з’єднання необхідно підключати перетворювачі при вимкнених ПЛК, з дозволу викладача.

Деталізований опис постановки задачі. Необхідно реалізувати наступну 
схему інформаційних потоків (рис.3.4):

КП1 КП2 КП3

робоче місце 7 робоче місце 8 робоче місце 9

РС8
Citect

IOServerl
varl
var 2 1
var 3 Vh

3
var 4 2 СЛ

$
var 5 3

C O

£
m

Qо
2
Vh<D
•S

var 6
var 7 4
var 8

var 9
var 10 5
var 11

ПЛК 8
W1
W2

2
W3

^  W4

со£mQо

ПЛК7
W1

c-» 4 W2
Л— W3

ПЛК9
W1

ON 5 W2
Л— W3 Рис.3.4.

Коротка характеристика інформаційних потоків (за номерами):
Характеристика інформаційних потоків співпадає з ЧАСТИНОЮ 1 даної 

лабораторної роботи:
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- потоки 1,2,3 аналогічно робочому місцю 8;
- потік 4 аналогічно як потік 1 для роб. місця 7;
- потік 5 аналогічно як потік 1 для роб. місця 9.

Послідовність виконання роботи.

1) Зібрати лабораторну установку.________________________________
УВАГА! Porti ПЛК Twido і COM-порт ПК не ізольовані, тому для безпечного з’єднання 

необхідно підключати перетворювачі при вимкнених ПЛК, з дозволу викладача.

2) Запустити на виконання Citect Explorer і створити проект, відповідно до 
завдання, якщо змінні по вузлам (в десятковому форматі):

• ПЛК7: W1,W2,W3 відповідно регістри 34,35,36.
• П Л К 8 ^ 1 ^ 2 ^ 3 ^ 4  відповідно регістри 11,12,13,8.
• П Л К 9 ^ 1 ^ 2 ^ 3  відповідно регістри 67,68,69.
Звернути увагу, що система повинна управляти перетворювачем інтерфейсів. 

При створенні проекту врахувати, що час відновлення змінних повинен дорівнювати 
5с.

3) В Graphics Builder створити сторінку з елементами для відображення та 
вводу змінних. Запустити виконавчу систему Vijeo Citect. Досягнути позитивного 
виконання задачі відповідно до рис.3.4.

4) На РС7 та РС9 запустити на виконання сканер СОМ-порту compt.exe з 
такими ж параметрами передачі, що і для системи з MODBUS (RTS в compt.exe 
повинен бути вимкнений, щоб не вмикати трансмітер перетворювача!).

5) Проаналізувати отримані дані з compt.exe. Звернути увагу на те, яким чином 
VijeoCitect проводить опитування регістрів для кожного ПЛК, скільки запитів 
необхідно для реалізації читання всіх регістрів з всіх ПЛК. Зробити копію екрана з 
вікном compt.exe, в якому відображаються отримані протягом 1 хв запити. 
Результати аналізів занотувати.

6) Збільшити адресу регістру var3 на 10 (наприклад з %MW13 до %MW23). 
Повторити пункт 3.

7) Повторювати пункти 3 та 4 потрібно до тих пір, поки для читання регістрів з 
ПЛК8 не будуть йти по 2 запити. Визначити приблизну максимальну величину 
різниці між номерами адрес регістрів для реалізації групових запитів в SCADA 
VijeoCitect для протоколу MODBUS. Результат запишіть.

Оформлення роботи.
До захисту готовляться всі занотовані результати з поясненнями.

Перевірка виконання роботи та питання до захисту.

Викладачем вибірково перевіряється виконання всіх пунктів роботи та 
занотовані результати. Кожен результат студент повинен пояснити. У випадку 
виникнення помилок або запитань щодо проведення певного пункту, цей пункт 
необхідно буде повторити.

1. Розкажіть про необхідність використання активної коробки TSX P ACC01.
Які правила її підключення?
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2. В якому режимі повинен працювати адаптер TSX PCX1031 при 
підключені до шини через коробку TSX P ACC01?

3. Якими Веденими (адреси) на шині були РС7 та РС9?
4. Роз’ясніть відмінність понять: Клієнт-Сервер та Ведучий-Ведений.
5. Чи можливо в MODBUS RTU забезпечити передачу від Slave до Slave? 

Якщо можливо, то яким чином?
6. Яким чином в VijeoCitect настроюється управління адаптером- 

перетворювачем інтерфейсів? Навіщо його настроювати в даній частині 
лабораторної роботи?

7. Роз’ясніть результати пунктів 4-6.

Додаток 3.1. Конфігурування VijeoCitect для роботи з MODBUS RTU.

Д.3.1.1. Кластерна система VijeoCitect. Система виконання VijeoCitect 
складається із клієнтської (наприклад Дисплейні клієнти) та серверної частини. Всі 
сервери (I/O Server, Alarm Server, Trend Server, Report Server) запускаються в межах 
визначених кластерів -  логічне об’єднання серверів на різних комп’ютерах. 
Найбільш простий варіант системи - Standalone, тобто коли всі типи серверів 
знаходяться в межах одного комп’ютеру, а система має один кластер. Саме такий 
тип використовується в лабораторній роботі. В цьому випадку на одному ПК може 
знаходитись тільки один основний сервер кожного виду. Тим не менше необхідно 
створити один кластер, до якого всі сервери будуть прив’язуватись по замовченню. 
Тобто при створенні серверів в системах такого типу крім його імені нічого вводити 
не потрібно.

Д.3.1.2. Загальні концепції настройки обміну даними вводу/виводу в 
VijeoCitect.

В VijeoCitect за обмін даними вводу/виводу (база даних реального часу) 
відповідає I/O Server. Структура комунікацій має наступний вигляд (рис.3.5):

I/O Servers 
- Boards 
-- Ports 
— Modems 
---- I/O Devices
Тобто в CitectExplorer в розділі Communications 

створюється I/O Server, в межах якого визначаються 
логічні або фізичні комунікаційні плати (Boards), на 
кожній з яких є комунікаційні порти (Ports). При 
необхідності використання модемів вони 
налаштовуються в Modems. Порти являють собою 
виходи на промислову мережу, де знаходяться 
пристрої, які в VijeoCitect конфігуруються в розділі 
I/O Devices.

Для зв’язку з зовнішніми засобами вводу/виводу в лабораторній роботі не 
використовується OFS. Обмін по MODBUS RTU проводиться через драйвер 
протоколу MODBUS.

Для автоматичного конфігурування всіє структури потрібної комунікації 
бажано спочатку скористатися помічником Express I/O Device Setup, після чого всі

ГОЙ Express I/O Device Setup 

Clusters 

0  I/O Servers 

^Alarnn Servers 

^tsTrend Servers 

(/^Report Servers 

Л ..Network Addresses 

.ДІ Boards 

A  Ports 

^Modems 
m  I/O Devices 
*§1/0 Remapping

Рис.3.5.Настройка комунікацій 
в VijeoCitect
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інші настройки підрихтувати під задану задачу. В наступних підпунктах розписано 
призначення настройок всіх елементів структури комунікації для MODBUS RTU. 

Д.3.1.3. Boards.
Board Name -  довільне унікальне ім’я плати
Board Type -  тип плати, при використанні СОМ-портів вибирається тип COMx 
Address , I/O Port, Interrupt, Special Opt - при використанні СОМ-портів 

залишається
Д.3.1.4. Ports.
PortName - довільне унікальне ім’я порта
Port Number - номер порта, для COM1=1 для COM2=2 і т.д.
Board Name -  ім’я плати
Baud Rate - швидкість передачі даних (наприклад 9600)
Data Bits -  кількість бітів даних в символі , для MODBUS RTU = 8, для 

MODBUS ASCII = 7.
Stop Bits - кількість стопових бітів в символі 
Parity -  тип біту паритету
Special Opt - Спеціальні настройки для порту. Для СОМ портів вони необхідні 

для настройки поведінки сервісних сигналів RS-232. Нижче наведені опції для 
настройки поведінки сигналу RTS:

-t: драйвер включить RTS тільки при передачі
-ti: RTS включається тоді, коли достатньо місця в приймальному буфері, щоб 

отримати вхідні символи, і відключається коли недостатньо.
-to: RTS включається тоді, коли у вихідному буфері є символи для передачі 
-tPRE,POST: перед передачею повідомлення драйвер включає RTS на PRE 

мілісекунд, передає повідомлення, очікує POST мілісекунд перед відключенням RTS. 
Д.3.1.5. I/O devices.
Name -  довільне унікальне ім’я пристрою (вузла в промисловій мережі)
Number -  унікальний номер для пристрою
Address -  адреса пристрою на мережі, для MODBUS RTU/ASCII відповідає 

адресі Веденого
Protocol -  тип протоколу, для MODBUS RTU/ASCII вибирається один із типів 

MODBUS пристроїв (див. Д.3.1.7)
Port Name -  ім’я порту, до якого підключений даний вузол
Memory -  у випадку створення внутрішніх змінних SCADA, вибирається TRUE
Д.3.1.6. Розширені настройки I/O devices
Для розширеної настройки I/O devices існують додаткові поля. Поява 

додаткових опцій настройки у вкладці I/O devices (і у будь яких інших вікнах 
настройки) доступна по кнопці "F2".

Серед полів розширеної настройки слід виділити настройки кеша. При 
відсутності кешування даних, I/O Server при кожному запиті на оновлення даних 
анімації від Дисплейних клієнтів, будуть проводити обмін з джерелом даних, тобто з 
I/O Device. Якщо для даного I/O Device буде виділений та налаштований кеш, то 
Дисплейні клієнти будуть отримувати дані саме з кешу а не безпосередньо з 
пристрою. Оновлення кешу буде проводитись з періодичністю Cache Time, а.

Cache -  для включення кешування виставляється TRUE.
Cache Time -  при включеному кешуванні, виставляється період відновлення 

кешу в мілісекундах (рекомендується не менше 300 мс)
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Д.3.1.7. Особливості вибору протоколу MODBUS в I/O devices.
Реалізація MODBUS протоколу може відрізнятися в пристроях різних 

виробників, наприклад в адресації змінних або в розміщенні бітів в пам’яті і т.д. 
Крім того адреси змінних (поле Address) пристроїв в інтерфейсі настройки тегів 
VijeoCitect (Variable Tag) теж відрізняються. Тому в VijeoCitect передбачені декілька 
типів протоколу MODBUS, які враховують ці особливості. Ці протоколи 
відрізняються:

-  номером першого регістру/катушки в пристрої; деякі пристрої (TSX Quantum 
або Momentum) використовують регістр/катушку з номером 1 як самий 
перший, а інші (наприклад TSX Premium) використовують номер 0;

-  яким чином адресується самий перший біт в межах регістру: від 0 до 15, чи 
від 1 до 16.

-  яким чином задається адреса змінної пристрою в Variable Tag (див. Д.3.1.8); 
Для вузлів з адресацією як в TSX Twido, TSX Micro та TSX Premium тип

протоколу вибирається MODBUS30.
Д.3.1.8. Конфігурування Variable Tag. Для ідентифікації джерела даних для 

VariableTag при виборі типу протоколу MODBUS30 в поле Address вписується 
адреса в форматі PL7/UNITY (наприклад %MW100).

Додаток 3.2. Коробка підключення TSX P ACC01.

Реалізація з’єднання контролерів TSX Micro/ TSX Premium/ TSX Twido по 
мережі MODBUS RTU/ASCII (крім TSX Premium) або UNITELWAY (крім TSX 
Twido) з використанням термінальних портів можливе з використанням спеціальної 
коробки TSX P ACC01. Ця коробка гальванічно розв’язує трансивер RS-485 
контролера від загальної шини, що дозволяє безпечно реалізовувати шинні топології 
на відстані до 1000 м (замість 10 м при відсутності розв’язки). Крім того дана 
коробка дозволяє підмикати адаптери перетворювачі TSX PCX 1031 до загальної 
шини.

Коробка TSX P ACC01 має бути підключена до джерела живлення 5 В, яке 
присутнє на вбудованому термінальному порті ПЛК. Порт TER на коробці 
відповідає порту Port1 (для Twido) або TER (для Premium) на контролері, який 
живить дану коробку. Винятком є відсутність сигнальної лінії для управління станом 
трансмітера на перетворювачі OFF

о_
Тобто

-Б-
гг

S2
Положение для завершения 
линии UNI-THLWA^ ^ * 1

OFF 
. гл_

-ІЇ-
~nr
S2

ЩЕ

ÏL
S м

UNI-TELWAY 
ведомый или 
символьный 

режим

з боку RS-485. 
перетворювач, який
підключається до TSX P 
ACC01 (наприклад TSX PCX 
1031) повинен управлятися зі 
сторони RS-232 сигналом 
RTS.

На рис. 3.6 показане 
внутрішнє наповнення
коробки: клеми для
підключення шинного
кабелю, перемикач вибору режиму контролера (S1), перемикач термінатору лінії 
(S2). S1 задає операційний режим роботи TER-порту, аналогічно перемикачу 
TER/OTHER стану перетворювача в режимі точка-точка (див. додаток 2.3).
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Перемикачем Б2 виставляється в кінцевих, тобто термінальних коробках. На 
лабораторній установці перемикачі на всіх коробках 81=8, а 82=ОЕЕ (окрім КП1). На 
рис.3.6 показані 82=ОК в коробках КП1 та КП3, але в лабораторії за коробкою КП3 
вправо йдуть інші коробки відгалуження, тому вона не являється термінальною.

Додаток 3.3. Особливості роботи драйверів при реалізації запитів в MODBUS
RTU.

Сучасні SCADA при створенні змінних намагаються оптимізувати мережний 
трафік між базою даних реального часу та ПЛК. Необхідність такої оптимізації 
розглянемо на прикладі.

Читання змінних %MW5, %MW10 та %MW15 можна реалізувати трьома 
окремими запитами на читання однієї змінної, або одним запитом на читання 11 
змінних, оскільки MODBUS дозволяє робити запити як на одиночне так і на групове 
читання та запис. При груповому читанні, 8 змінних (16 байт) є лишніми, однак 
сумарний час транзакцій буде менший порівняно з одиночним. Тому доцільно змінні 
в пам’яті ПЛК розміщувати по порядку, щоб організувати їх групове читання. Не 
зважаючи на "дірки" в просторі змінних, драйвер SCADA, як правило, все одно 
зчитує змінні груповими запитами. Тим не менше, загальноприйнятою мірою для 
зменшення трафіку та мінімального часу обміну між пристроями є послідовне 
розміщення мережних змінних в пам’яті контролерів.
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ЛАБОРАТОРНА РОБОТА № 4 (модуль 2).

Використання шини MODBUS RTU та MODBUS TCP/IP для зв’язку між 
ПЛК. Перевірка розрахованого часу транзакції.

ЧАСТИНА 1.

Тривалість: 1 акад. година (0.5 пари).
Мета: Навчитись реалізовувати комунікаційний обмін між ПЛК з

використанням комунікаційних функцій; дослідна перевірка розрахованого часу 
транзакції по мережі MODBUS RTU.

Лабораторна установка.

Лабораторна робота виконується на робочих місцях 4 та 7. Одна бригада -  одне 
робоче місце. Інші дві бригади в цей час виконують частину 2.

Апаратне забезпечення. Лабораторна 
установка складається з: контролерів M340 та 
Twido, які з’єднані між собою по MODBUS RTU 
на базі інтерфейсу RS-485; комп’ютера, 
підключеного до М340 через USB-інтерфейс 
(Рис.4.1).

Підключення М340 до MODBUS RTU 
проводиться через інтегрований в CPU P341000 
послідовний порт з позначенням Modbus. Даний порт реалізує інтерфейси RS- 
232/RS-485 з підтримкою протоколів MODBUS RTU/ASCII Master/Slave та 
символьного режиму. Підключення до ліній інтерфейсу проводиться через RJ-45 
з’єднувач.

Підключення Twido до MODBUS RTU проводиться через адаптер TWD NAC 
485T, який включений в модуль TWD XCP ODM. Цей адаптер являється другим 
комунікаційним портом контролера (Port2) і реалізовує інтерфейс RS-485 з 
підтримкою протоколів MODBUS RTU/ASCII Master/Slave, Remote Link та 
символьного режиму. Підключення до ліній інтерфейсу проводиться через клемну 
колодку на адаптері.

Фізичне з’єднання портів контролерів М340 та Twido проводиться через клемну 
колодку.______________________________________________________________

УВАГА! Порти ПЛК М340 та Twido не ізольовані, тому для їх безпечного з’єднання підключення 
необхідно проводити при вимкненому живленні одного з ПЛК, з дозволу викладача.

Twido M340

Port2
О

Porti
о

USB

D-
USB кабель

ПModbu

MODBUS RTU на RS-485 

Рис.4.1.

USB

PC

Програмне забезпечення. На комп’ютері використовується середовище UNITY 
PRO для програмування М340. З’єднання ПК та М340 проводиться через драйвер 
USB. У Twido записана програма, яка змінює значення змінних відповідно до 
завдання.

Загальна постановка задачі. Цілі роботи:
1) реалізувати поставлену задачу, оформлену у вигляді схеми інформаційних 

потоків (рис.4.2); ця задача передбачає обмін даними між М340 та Twido;
2) перевірити розрахований час транзакції з отриманими в експерименті.
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Деталізований опис постановки задачі. Реалізація клієнтських запитів в М340 
для читання вихідних/внутрішніх регістрів по протоколу MODBUS проводиться 
через функцію READ_VAR, яка описана в додатку 4.1. Постановка задачі передбачає 
виконання запиту по ініціації користувача. Необхідно створити таку програму, яка б 
розраховувала час між моментом ініціації клієнтського запиту та повернення 
відповіді. Загальна методика розрахунку такого часу наведена в додатку 4.2.

Рис.4.2. Схема інформаційних потоків до частини 1 лабораторної роботи №4.

Послідовність виконання роботи.

1) Зібрати лабораторну установку._______________________________________
УВАГА! Порти ПЛК М340 та Т и^о не ізольовані, тому для їх безпечного з’єднання підключення 

необхідно проводити при вимкненому живленні одного з ПЛК, з дозволу викладача.

2) Завантажити UNITY PRO. Створити новий проект: при виборі контролера 
виставити опцію "Show All Version"; вибрати BMX P34 1000 (OS.2.0).
3) Створити конфігурацію для послідовного порту (в Project Browser в розділі 
Configuration -> BMX P34 1000 ->Serial Port):

- Function=Modbus link;
- Type = Master;
- Transmission Speed = 19200;
- DATA=RTU;
- Stop=1 bit;
- Parity=Even;
- Phisical=RS485;

4) Створити або імпортувати секцію з програмою та змінними (див.рис.4.6 та 
рис.4.7).

5) Для імпорту виділити в Project Browser в розділі Program->Tasks->Mast->Sections- 
> контекстне_меню->Import..., вказати файл PKIS4_RTU.XST. Після імпорту 
необхідно перевірити створення змінних в розділі Variables & FB instances згідно 
з рис.4.7. Необхідно також виставити опції: Tools->Project Settings -> Variables -> 
Directly represented array variables = так; Tools->Project Settings -> Variables -> 
Allow dynamic arrays (ANY_ARRAY_XXX) = так.

6) Скомпілювати проект (Build->Rebuild All Project). При виникненні помилок 
повторити правильність виконання пунктів 2-4.

7) Завантажити проект в ПЛК М340 та запустити контролер на виконання:
-  в меню PLC виставити Standard Mode;
-  в меню PLC->Set Address вибрати: Media=USB; Address=SYS
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-  перевірити зв’язок кнопкою Test Connection, якщо зв’язок відсутній -  
перевірити з'єднання;

-  провести з’єднання UNITY PRO з M340: PLC->Connect;
-  завантажити проект в ПЛК: PLC->Transfer Project to PLC;
-  запустити контролер на виконання (PLC->RUN)

8) Створити таблицю анімацій відповідно рис.4.8: виділити всю секцію програми і в 
контекстному меню вибрати Initialize Animation Table.

9) Зчитати 100 змінних з ПЛК Twido (%MW0-%MW99) шляхом зміни змінної 
send_cmd в 1. Результат роботи комунікаційної функції перевірити в змінних para, 
а зчитані змінні в масиві result. При позитивному результаті (відсутність помилок 
в para) перейти до наступних пунктів.

10) Занотувати значення Tm_c1, Tm_c2, Tm_c3, Tsl_c 1 та trans_time в таблицю 
формату Таб.4.1.

11) Повторити пункти 8-9 ще 9 разів.
12) Змінити кількість регістрів читання на 50 (%MW0-%MW49). Повторити пункти 8­

10.
13) Розрахувати Tsend та Trecv відповідно до формату запитів MODBUS та 

швидкісних характеристик мережі, занотувати результати в поле 
"кільк.регістрів/Tsend/Trecv" для 100 та 50 регістрів. Вибрати зі створеної таблиці 
записи з найбільшим, найменшим та середнім (орієнтовно) значеннями trans_time 
для 100 та 50 регістрів (всього 6 записів). Розрахувати для цих записів 
Trans_timemin та Trans_timemax по формулам відповідно (4.1) та (4.2) та занотувати 
у відповідні поля, при умові що Tsl_c2=Tsl_c1.

Оформлення роботи.
До захисту готовиться таблиця типу Таб.4.1.

Таб.4.1.
№
дос
ліду

кільк.
регістрі

в /
Tsend/
Trecv

Tm c1 
мс

Tsl_c1
мс

Tm c2 
мс

Tm c3 
мс

trans_time
мс

Trans_timemin
мс

Trans_timemax
мс

1 100/
Tsend/

10 Trecv
11 50/

Tsend/
20 Trecv

Перевірка виконання роботи та питання до захисту.
Викладачем вибірково перевіряється виконання всіх пунктів роботи та 

занотовані результати. Кожен результат студент повинен пояснити. У випадку 
виникнення помилок або запитань щодо проведення певного пункту, цей пункт 
необхідно буде повторити.

Перед захистом роботи необхідно пояснити постановку задачі та кінцеві 
результати.

1. Поясніть методику розрахунку часу транзакції, яка використовується в 
даній частині лабораторної роботи. Від чого залежить час транзакції?
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2. Яким чином в програмі для лабораторної роботи визначається час циклів 
Ведучого та Веденого?

3. Яким чином реалізуються комунікаційні функції читання та запису 
внутрішніх регістрів по протоколу MODBUS в контролерах Premium та 
M340? Поясніть призначення кожного параметру в цих функціях.

4. Яким чином контролюється результат виконання комунікаційних 
функцій? Що таке біт активності?

5. Прокоментуйте результати з таблиці 4.1? Поясніть чому вони 
відрізняються? Що змінилося при зменшенні кількості регістрів, які 
читаються, і чому?

ЧАСТИНА 2.

Тривалість: 1 акад. година (0.5 пари).
Мета: Навчитись реалізовувати комунікаційний обмін між ПЛК з 

використанням комунікаційних функцій; дослідна перевірка розрахованого часу 
транзакції по мережі MODBUS/TCP.

Лабораторна установка.

Лабораторна робота виконується на робочих місцях 3 та 8. Одна бригада -  одне 
робоче місце. Інші дві бригади в цей час виконують частину 1.

Апаратне забезпечення. Лабораторна установка складається з: контролерів 
Premium (Premium 1 та Premium2), які з’єднані між собою по Ethernet з 
використанням MODBUS/TCP; комп’ютера, підключеного до Premium 1 через 
адаптер-перетворювач TSX PCX1031 та протоколу UNI-TELWAY (Рис.4.3).

Підключення Premium до Ethernet 
проводиться через інтегрований Ethernet порт з 
позначенням ETY PORT Ethernet 10/100. Даний 
порт реалізовує мережу EthernetII/802.3 з 
підтримкою багатьох протоколів, зокрема 
MODBUS/TCP Клієнт та Сервер 
(MODBUS/TCP Сервер є інтегрованим на рівні 
операційної системи). Фізичне з’єднання між 
контролерами відбувається через Ethernet 
Switch.

Програмне забезпечення. На комп’ютері 
використовується середовище UNITY PRO для 
програмування Premium1. З’єднання ПК та 
Premium1 проводиться через драйвер UNITELWAY. У Premium2 записана програма, 
яка змінює значення змінних відповідно до завдання.

Загальна постановка задачі. Цілі роботи:
1) реалізувати поставлену задачу, оформлену у вигляді схеми інформаційних 

потоків (рис.4.4); ця задача передбачає обмін даними між Premium 1 та 
Premium2;

2) перевірити розрахований час транзакції з отриманими в експерименті.

Рис.4.3.
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Деталізований опис постановки задачі. MODBUS/TCP Сервер реалізований в 
Premium на рівні операційної системи (достатньо тільки сконфігурувати порт 
Ethernet). Реалізація клієнтських запитів в Premium для читання вихідних/внутрішніх 
регістрів по протоколу MODBUS проводиться через функцію READ_VAR, яка 
описана в додатку 4.1. Постановка задачі передбачає виконання запиту по ініціації 
користувача. Необхідно створити таку програму, яка б розраховувала час між 
моментом ініціації клієнтського запиту та повернення відповіді. Загальна методика 
розрахунку такого часу наведена в додатку 4.3.

* - для робочого місця 3: IP Premium1=192.168.9.31; IP Premium2=192.168.9.32 
- для робочого місця 8: IP Premium1=192.168.9.42; IP Premium2=192.168.9.41

Рис.4.4. Схема інформаційних потоків до частини 2 лабораторної роботи №4.

Послідовність виконання роботи.

1. Зібрати лабораторну установку.
2. Завантажити UNITY PRO. Створити новий проект: при виборі контролера 
виставити опцію "Show All Version"; вибрати TSX P57 2634M (OS.2.0).
3. Створити конфігурацію для мережі Ethernet:

3.1. Створити нову мережу: в Project Browser в розділі Communication->Networks - 
> контекстне меню- ^ e w  Network-> вибрати Ethernet.

3.2. Для створеної мережі налаштувати:
-  Model Family=TCP/IP Regular Connection.
-  IP адресу Premium1 відповідно до робочого місця (вкладка IP Configuration), 

маска підмережі 255.255.255.0;
-  відповідність логічних адрес типу Network. Station реальним фізичним 

адресам IP (див.Д.4.1.5);
3.3. Прив’язати створену конфігурацію до реального порту: в Project Browser в 

розділі Configuration -> TSX RKY 6EX -> TSX ETY Port
-  Channel0->Function = ETH TCP/IP
-  Channel0->Net Link = "назва створеної мережі в п.3.1." (наприклад 

Ethernet_1)
3.4. Закінчити конфігурацію: меню Edit->Validate

4. Створити або імпортувати секцію з програмою та змінними (див.рис.4.10 та 
рис.4.7).

Для імпорту виділити в Project Browser в розділі Program->Tasks->Mast->Sections-> 
контекстне_меню->Import..., вказати файл PKIS4_TCP.XST. Після імпорту 
необхідно перевірити створення змінних в розділі Variables & FB instances згідно з 
рис.4.7. Необхідно також виставити опції: Tools->Project Settings -> Variables ->
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Directly represented array variables = так; Tools->Project Settings -> Variables -> 
Allow dynamic arrays (ANY_ARRAY_XXX) = так.
5. Скомпілювати проект (Build->Rebuild All Project). При виникненні помилок 

повторити правильність виконання пунктів 2-4.
6. Завантажити проект в ПЛК Premium1 та запустити контролер на виконання:

-  в меню PLC виставити Standard Mode;
-  в меню PLC->Set Address вибрати: Media= UNTLW01; Address=SYS
-  перевірити зв’язок кнопкою Test Connection, якщо зв’язок відсутній -  

перевірити з'єднання;
-  провести з’єднання UNITY PRO з Premium1 : PLC->Connect;
-  завантажити проект в ПЛК: PLC->Transfer Project to PLC;
-  запустити контролер на виконання (PLC->RUN)

7. Створити таблицю анімацій відповідно до рис.4.8: виділити всю секцію програми 
і в контекстному меню вибрати Initialize Animation Table.

8. Зчитати 100 змінних з ПЛК Premium2 (%MW0-%MW99) шляхом зміни змінної 
send_cmd в 1. Результат роботи комунікаційної функції перевірити в змінних para, 
а зчитані змінні в масиві result. При позитивному результаті (відсутність помилок 
в para) перейти до наступних пунктів.

9. Занотувати значення Tm_c1, Tm_c2, Tm_c3, Tsl_c 1 та trans_time в таблицю 
формату Таб.4.2.

10. Повторити пункти 8-9 ще 9 разів.
11. Змінити кількість регістрів читання на 50 (%MW0-%MW49). Повторити пункти 8­

10.
12. Вибрати зі створеної таблиці записи з найбільшим, найменшим та середнім 

(орієнтовно) значеннями trans_time для 100 та 50 регістрів (всього 6 записів). 
Розрахувати для цих записів Trans_timemin та Trans_timemax по формулам 
відповідно (4.4) та (4.5) та занотувати у відповідні поля, при умові що:
-  для Trans_timemin - NAT1=NAT2=1 мс;
-  для Trans_timemax - NAT1=NAT2=10 мс,
-  Tsl_c2=Tsl_c3.

Оформлення роботи.
До захисту готовиться таблиця типу Таб.4.2.

Таб.4.2.
№
дос
ліду

кількіст
ь

регістрі
в

Tm c1 
мс

Tsl_c1
мс

Tm c2 
мс

Tm c3 
мс

trans_time
мс

Trans_timemin
мс

Trans_timemax
мс

1 100

10
11 50

20
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Перевірка виконання роботи та питання до захисту.
Викладачем вибірково перевіряється виконання всіх пунктів роботи та 

занотовані результати. Кожен результат студент повинен пояснити. У випадку 
виникнення помилок або запитань щодо проведення певного пункту, цей пункт 
необхідно буде повторити.

Перед захистом роботи необхідно пояснити постановку задачі та кінцеві 
результати.

1. Поясніть методику розрахунку часу транзакції, яка використовується в 
даній частині лабораторної роботи. Яким чином в програмі для 
лабораторної роботи визначається час циклів Клієнту та Серверу?

2. Яким чином реалізуються комунікаційні функції читання та запису 
внутрішніх регістрів по протоколу MODBUS в контролерах Premium та 
M340? Поясніть призначення кожного параметру в цих функціях.

3. Яким чином контролюється результат виконання комунікаційних функцій ? 
Що таке біт активності?

4. Прокоментуйте результати з таблиці 4.2? Поясніть чому вони 
відрізняються? Що змінилося при зменшенні кількості регістрів, які 
читаються, і чому?

Додаток 4.1. Комунікаційні функції UNITY для читання/запису 
внутрішніх/вихідних регістрів.

Д.4.1.1. Використання комунікаційних функцій в UNITY. Для роботи з 
комунікаціями в контролерах Quantum, Premium та M340, які програмуються в 
середовищі UNITY PRO використовуються комунікаційні функції. Для зчитування 
внутрішніх/вихідних регістрів MODBUS в М340 та Premium використовується 
функція READ_VAR, для запису - WRITE_VAR.

Д.4.1.2. Функція READ_VAR. Для зчитування внутрішніх/вихідних регістрів 
або бітів MODBUS в М340 та Premium використовується функція READ_VAR. 
Синтаксис функції в ST:

READ VAR(Address, Object Type, First Object, Object Number, Management Param, 
Receiving_Array);
Address ARRAY [0.. 5] O FINT 

для Premium

ARRAY [0.. 7] O FINT 
для M340

Адреса вузла отримувача запиту; для отримання 
цього масиву в М340 використовується функція 
ADDM (див.Д.4.1.4) а в Premium функція ADDR 
(див.Д.4.1.5).

Object Type STRING Тип об’єкта зчитування: ’%M’ або ’%MW’
First Object DINT Адреса початкового об’єкту
Object Number INT Кількість об’єктів
Management_Param ARRAY [0.. 3] O FINT Таблиця управління обміном (див.Д.4.1.6)

Receiving Array ARRAY [n... m] OF 
INT

Масив, який вміщує значення прочитаних 
змінних
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Д.4.1.3. Функція WRITE_VAR. Для запису внутрішніх/вихідних регістрів або 
бітів MODBUS в М340 та Premium використовується функція WRITE_VAR. 
Синтаксис функції в ST:

WRITE VAR(Address, Object Type, First Object, Object Number, Data to Write, 
Management Param);
Address ARRAY [0.. 5] O FINT 

для Premium

ARRAY [0.. 7] O FINT 
для M340

Адреса вузла отримувача запиту; для отримання 
цього масиву в М340 використовується функція 
ADDM (див.Д.4.1.4) а в Premium функція ADDR 
(див.Д.4.1.5).

Object Type STRING Тип об’єкта запису: ’%M’ або ’%MW’
First Object DINT Адреса початкового об’єкту
Object Number INT Кількість об’єктів
Data_to_Write ARRAY [n... m] OF 

INT
Масив, який вміщує значення даних, які треба 
записати

Management_Param ARRAY [0.. 3] O FINT Таблиця управління обміном (див.Д.4.1.6)

Д.4.1.4. Функція ADDM (для М340). Функція ADDM призначена для 
перетворення символьної строки в адресу (у вигляді масиву), яка використовується у 
ряді комунікаційних функцій контролерів М340, зокрема READ_VAR та 
WRITE VAR.

Addr Array := ADDM(Addr String);
Addr_String STRING Адреса вузла отримувача в символьному форматі: 

для протоколу MODBUS:
’r.m.c.e’

де:
-  r: номер шасі з комунікаційним модулем 

(для інтегрованого порту Modbus завжди = 
0) . .-  m: номер комунікаційного модуля (для 
інтегрованого порту Modbus завжди = 0)

-  с: номер каналу (для інтегрованого порту 
Modbus завжди = 0)

-  е: адреса Веденого (від 1-го до 247)
Addr_Array ARRAY [0.. 7] O FINT Адреса вузла отримувача запиту у вигляді 

масиву;
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Д.4.1.5. Функція ADDR (для Premium). Функція ADDR призначена для 
перетворення символьної строки в адресу (у вигляді масиву), яка використовується у 
ряді комунікаційних функцій контролерів Premium, зокрема READ_VAR та
WRITE VAR.
Addr_Array
Addr_String

= ADDR(Addr String);
STRING Адреса вузла отримувача в символьному форматі: 

для протоколу MODBUS:
’{network.station}SYS’

де:
-  network: номер мережі
-  station: номер станції
-  SYS: символьна константа (системний Сервер)

Специфіка синтаксису визначена універсальністю комунікаційних 
функцій Premium. Зв’язок логічної адреси типу "network.station" з 
дійсною IP-адресою отримувача налаштовується при створенні в 
UNITY PRO комунікації Ethernet, в таблиці на вкладці Messaging. 
Адреси Station обов’язково повинні знаходитись в межах 100-164.

iguration Messaging 1 ) Scanning ] ' заі Data ] SNMP ] . ddress Server 1 E
для MODBUS TCP задавати не потрібно■ oroFile

N t̂tfork)^ Station 1

action configuration

network.station

s Control

Г

XV AY
address M ode

...........\
Access

; 8.132 M ULTI у F C
Trt+ I-___ ^ M ULTI у P
9.142 M ULTI T P

M ULTI У P
M ULTI У P
M ULTI У P
M ULTI У P

IP-адреса
IP address

>.168.9.32 A

192.168.9.42

Addr_Array ARRAY
[0.. 5]
OF INT

Адреса вузла отримувача запиту у вигляді масиву;

Д.4.1.6. Таблиця управління обміном (Managenent_Parameter). Таблиця 
управління обміном (іншими словами комунікаційні параметри обміну) потрібні для 
управління та контролю за роботою комунікаційної функції. Ця таблиця включає 4- 
ри слова:______ ___________________ ____________________________________

Номер слова в 
таблиці

Старший байт слова Молодший байт слова

1 номер обміну 
(Exchange number)

0-й біт -  біт активності (Activity Bit),
переводиться системою в 1 при початку 
обробки, в 0 -  при поверненні результату

2 operation report
00 -  немає помилок при 
обробці;
FF -  повідомлення 
помилки;

communication report:
00 -  немає помилок при обробці;
xx -  номер помилки (додаткова інформація в
довідковій системі UNITY PRO);

3 Time-out: дозволений тайм-аут для очікування відповіді, задається в 100 
мс (10 = 1с), 0 -  нескінченне очікування

4 Length: для READ VAR -  кількість отриманих байтів
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Додаток 4.2. Методика та програма розрахунку часу транзакції в мережі 
MODBUS RTU з контролерами М340 та Twido.

Д.4.2.1. Методика розрахунку. Методика розрахунку часу транзакції, яка 
використовується в даній роботі аналогічна як для інших систем, в яких обмін з 
мережею MODBUS RTU прив’язаний до циклу контролера, тобто обробка вхідних 
повідомлень проходить на початку циклу, а відправка вихідних -  в кінці (рис.4.5). 
Час транзації (Trans_time) залежить від: тривалості циклів Ведучого (Tm_c1, Tm_c2, 
Tm_c3); тривалості циклів Веденого (Tsl_c1, Tsl_c2); часу передачі по мережі запиту 
(Tsend) та відповіді (Trecv); часу надходження запиту до Веденого та відповіді до 
Ведучого, який буде впливати на Tsl_dev та Tm_dev. Таким чином, загальний час 
транзакції при тих саме Tm_c1, Tm_c2, Tm_c3, Tsl_c1 та Tsl_c2, але при різних 
Tsl_dev та Tm_dev може приймати значення:

1) мінімальне -  при Tsl_dev=Tsl_c1 та Tm_dev=Tm_c2, тобто кадри приходять 
перед зчитуванням входів циклів sl_c2 та m_c3:

Trans_timemin=Tm_c1 + Tsend + Tsl_c2 + Trecv + Tm_c3; (4.1)
2) максимальне -  при Tsl_dev=0 та Tm_dev=0, тобто кадри приходять відразу 

після зчитування входів sl_c1 та m_c2:
Trans_timemax=Tm_c1 + Tsend + Tsl_c1 + Tsl_c2 + Trecv + Tm_c2 + Tm_c3; (4.2)

3) між максимальним та мінімальним:
Trans_timemin < Trans_time < Trans_timemax (4.3)

Рис.4.5. Часова діаграма до розрахунку часу транзакції .
Д.4.2.2. Варіант програми для відправки запиту на читання, з фіксацією 

часу транзакції. На рис. 4.6 представлений лістинг програми для М340, яка 
відправляє запит на читання 100 регістрів (%MW0-%MW99) у Веденого з адресою 2. 
Виклик комунікаційної функції, що формує даний запит (READ_VAR) проводиться 
шляхом зведення змінної send_cmd в логічну "1", скидання значення даної змінної в 
0 проводиться програмно.

Фіксація часу транзакції проводиться шляхом використання таймеру (Timer). 
Час початку передачі запиту позначається міткою start_transaction а кінець транзакції 
- end_transaction (див. рис.4.5). Загальний час транзакції розраховується як час між 
командою send_cmd та міткою end_transaction (рис.4.5). Останнє значення часу 
циклу Веденого записується в його 0-вий регістр (%MW0). Змінні які 
використовуються в програмі наведені на рис. 4.7.
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(*тайиер  працює при к о м ан д і н а  читання  т а  п р о тяго м  т р а н з а к ц і ї* )
T im sr  (IN := s t a E t _ t E a n s a c t i o n  o r  send_cm d,

PT : = tjjflOOs) ;

(*про т р и в а л іс т ь  циклу в мс можна д і з н а т и с я  в наступному ц и к л і  ч е р е з  системну зм ін н у  %SW30*) 
i f  send_cmd and  p a t a [ 0 ] . Ü  t h e n  (*на н аступн ий  цикл п і с л я  в ід п р а в к и  зап иту*)

Тш _с1:=%sw30; 
s e n d _ c m d := f a i s e  ;

e n d _ i f ;

i f  e n d _ t E a n s a c t i o n  t h e n  (*на н аступн ий  цикл  п і с л я  отримання запиту*)
Т м _ с З :=%sw30;
end_transaction:=faise ;

end_if;
if send_cmd then (*відправллємо запит на читання*)

EEAIi_VAR (ADR := ADDH ( 1 0 . 0 . 0 . 2  1 ) , (*адреса Веденого=2*)
OBJ := 4 1 і , (* тип о б 'є к т у * )
ЖГИ := 0 ,  (*початковий  номер*)
NB := 1 0 0 , ( ^ к і л ь к і с т ь * )
GEST := раЕа,(*коммунікаційні параметри*)
RECP => Eesult); (*масив для отриманих даних*) 

staEt_tEansaction:=tEue; (*мітка початку транзакції*)
end_if;
(*при з а п у с к у  ф у н к ц і ї  0 -й  б і т  0 - г о  сл о в а  т а б л и ц і  - р а Е а -  в и с т а в л я є т ь с я  в 1*)
(*при отриманн і р е з у л ь т а т у  обробки ф у н к ц і ї  0 -й  б і т  0 - г о  с л о в а  т а б л и ц і  - p a r a -  в и с т а в л я є т ь с я  в 0*) 
i f  s t a E t _ t E a n s a c t i o n  and  n o t  p a E a [ 0 ] . 0  t h e n

end_tEansaction:=tEue; (*мітка закінчення транзакції*)
t E a n s _ t i m e : =Ті м є е . e t ;  (*при з а к ін ч е н н і  т р а н з а к ц і ї  за п а м 'я т о в у є м о  час* )
s t a t t _ t E a n s a c t i o n : = f a i s e  ;
Tm_c2: =%sw30; (* з а п а и ' ятовуєм о  п о п е р е д н ій  цикл*)
T s l _ c l : = E e s u l t [ 0 ] ;  (*в 0-м у  с л о в і  Ведений в ід п р а в л я є  зн ачен н я  о ст ан н ь о го  циклу*)

end  i f ;

Рис.4.6. Лістинг програми для відправки запиту на читання 100 внутрішніх регістрів з
фіксацією часу трназакції.

Variables 
Filter

I DDT Types Function Blocks | DFB Types |

[ Name _=J J* 17 EDT Г

Name Type ▼ Address ▼ Value Comment
ф  end_tran$action B00L мітка закінчення транзакції

È  В para ARRAY10..3) OF INT
♦  рага[0] INT лічильник запитів/біг активності
♦  рага[1] INT операційний звіг/комунікаційний звіт
♦  рага(2] INT тайм-аут
♦  рага(3] INT довжина

Е 3  result ARRAYI0..9910F INT отримані дані
Ф  send_CMD BOOL команда на відправку
Ф  $tart_transaction BOOL мітка початку транзакції
♦  Tm c1 INT час циклу Ведучого при відправки запиту
ф  Tm_c2 INT час циклу Ведучого перед отриманням відповіді
ф  Tm_c3 INT час циклу Ведучого в якому він отримує відповідь
Ф  trans_time TIME час траназкції
♦  Tsl_c1 INT час циклу Веденого

Variables DDT Types Function Blocks DFB Types 

г  Filter

_ r j Name _=J p

Name Ж. no. I Type

+ :_ f  Timer I TON

Рис.4.7. Опис змінних для програми .
Для перевірки роботи програми слід створити таблицю анімацій, як на рис.4.8. 

Для можливості зміни значення змінних в таблиці анімацій необхідно нажати кнопку 
Modification. Зведення змінної send_cmd в "1", приведе до виклику функції 
READ_VAR. Результат обробки функції можна проконтролювати через змінну 
para[1] (див. Д.4.1.6).
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Рис.4.8. Таблиця анімацій.
УВАГА! Для роботи програми в UNITY PRO 4 необхідно виставити наступні опції:

- Tools->Project Settings -> Variables -> Directly represented array variables = так
- Tools->Project Settings -> Variables -> Allow dynamic arrays (ANY_ARRAY_XXX) = так

Додаток 4.3. Методика та програма розрахунку часу транзакції в мережі 
MODBUS/TCP з контролерами Premium.

Д.4.3.1. Методика розрахунку. Методика розрахунку часу транзакції, яка 
використовується в даній частині роботи аналогічна як для інших систем, в яких 
обмін з мережею MODBUS TCP прив’язаний до циклу контролера, тобто обробка 
вхідних повідомлень проходить на початку циклу, а відправка вихідних -  в кінці 
(рис.4.6). Час транзації (Trans_time) залежить від: тривалості циклів Клієнта (Tm_c1, 
Tm_c2, Tm_c3); тривалості циклів Серверу (Tsl_c1, Tsl_c2); часу доступу 
комунікаційного модуля до мережі (NAT, для інтегрованого ETY порту Premium 
КА^Ю мс); часу надходження запиту до Серверу та відповіді до Клієнта, який буде 
впливати на Tsl_dev та Tm_dev. Таким чином, загальний час транзакції при тих саме 
Tm_c1, Tm_c2, Tm_c3, Tsl_c1 та Tsl_c2, але при різних Tsl_dev та Tm_dev може 
приймати значення:

1) мінімальне -  при Tsl_dev=Tsl_c1 та Tm_dev=Tm_c2, тобто пакети 
приходять перед зчитуванням входів циклів sl_c2 та m_c3:

Trans_timemin=Tm_c1 + NAT1 + Tsl_c2 + NAT2+ Tm_c3; (4.4)
2) максимальне -  при Tsl_dev=0 та Tm_dev=0, тобто пакети приходять відразу 

після зчитування входів sl_c1 та m_c2:
Trans_timemax=Tm_c1 + NAT1 + Tsl_c1 + Tsl_c2 + NAT2 + Tm_c2 + Tm_c3; (4.5)

3) між максимальним та мінімальним:
Trans_timemin < Trans_time < Trans_timemax (4.6)
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Рис.4.9. Часова діаграма до розрахунку часу транзакції .
Д.4.2.2. Варіант програми для відправки запиту на читання, з фіксацією 

часу транзакції. На рис. 4.10 представлений лістинг програми для Premium1, яка 
відправляє запит на читання 100 регістрів (%MW0-%MW99) у Клієнта з логічною 
адресою 9.132 (відповідне призначення адреси IP див. Д.4.1.5).Виклик 
комунікаційної функції, що формує даний запит (READ_VAR) проводиться шляхом 
зведення змінної send_cmd в логічну "1", скидання значення даної змінної в 0 
проводиться автоматично.

Фіксація часу транзакції проводиться шляхом використання таймеру (Timer). 
Час початку передачі запиту позначається міткою start_transaction а кінець транзакції 
- end_transaction (див. рис.4.9). Загальний час транзакції розраховується як час між 
командою send_cmd та міткою end_transaction (рис.4.9). Останнє значення часу 
циклу Сервера записується в його 0-вий регістр (%MW0). Змінні які 
використовуються в програмі наведені на рис. 4.7.

Для перевірки роботи програми слід створити таблицю анімацій, як на рис.4.8. 
Для можливості зміни значення змінних в таблиці анімацій необхідно нажати кнопку 
Modification. Зведення змінної send_cmd в "1", приведе до виклику функції 
READ_VAR. Результат обробки функції можна проконтролювати через змінну 
para[1] (див. Д.4.1.6).

УВАГА! Для роботи програми в UNITY PRO 4 необхідно виставити наступні опції:
- Tools->Project Settings -> Variables -> Directly represented array variables = так
- Tools->Project Settings -> Variables -> Allow dynamic arrays (ANY_ARRAY_XXX) = так
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(*таймер працює при ко м ан д і  на ч и т ан н я  т а  протягом  т р а н з а к ц і ї * )
T im er (Ш  := s t a r t _ t r a n s a c t i o n  o r  send_cm d,

FT := t#10G slG0m s ) ;

( *про т р и в а л іс т ь  циклу в  мс можна д і з н а т и с я  в наступному ц и к л і  ч е р е з  си стем ну  зм ін н у  %Sfl30*) 
їх  s e n d  ctnd an d  p a r a [ 0 ]  .□ t h e n  (*на наступний  цикл п і с л я  в ід п р а в к и  зап иту * )

T m _ c l: =%str3 0; 
se n d _ c m d := X a lse ;

e n d _ i f  ;

i f  e n d _ t r a n s a c t i o n  t h e n  (*на наступний  цикл п і с л я  отримання зап иту * )
Тт_сЗ : =%эш30;
en d  t r a n s a c t i o n : = f a l s e ;

e n d _ i f ;

i f  s e n d  ctnd t h e n  ( ’ в ід п р ав л я є м о  з а п и т  на  читання*)
READ_VÀR (ADR := ADDR ( 1{ 9 . 1 3 2 > s y s ' ) , ( * л о г іч н а  а д р е с а  в у з л а  С ер вер а  9 .1 3 2 * )

OEJ := Ч Ш 1 , ( *тип о б 'є к т у * )
MUH := □ , (*початковий  номер*)
ГІВ := 100, ( * к іл ь к і с т ь * )
GEST := p a r a , (*коммуні к а ц і й н і  параметри*)
RECP => r e s u l t ) ; ( *насив  д л я  отриманих даних*)

s t a r t  t r a n s a c t  i o n  : = t r u e ; (* м іт к а  п о чатк у  т р а н з а к ц і ї* )
e n d _ i f ;

(*при за п у с к у  ф у н к ц і ї  0 - й  б і т  0 - г о  с л о в а  т а б л и ц і  - p a r a -  в и с т а в л я є т ь с я  в 1*)
(*при отри м анн і р е з у л ь т а т у  обробки ф у н к ц і ї  0 -й  б і т  0 - г о  с л о в а  т а б л и ц і  - p a r a -  в и с т а в л я є т ь с я  в 0*) 
i f  s t a r t _ t r a n s a c t i o n  and  n o t  p a r a [ 0 ] .0  t h e n

en d  t r a n s a c t i o n : = t r u e ;  ( ' м і т к а  з а к ін ч е н н я  т р а н з а к ц і ї* )
t r a n s _ t i m e : = T im e r . e t ;  (*при з а к і н ч е н н і  т р а н з а к ц і ї  з а п а м 'я т о в у є м о  час*)  
s t a r t _ t r a n s a c t i o n : = f a i s e ;
Tm c2:=%sra30; ( * за п а м 'я т о в у є м о  п о п е р е д н ій  цикл*)
T s l _ c l : = r e s u l t [ 0 ] ; (*в  0-м у  с л о в і  Сервер в ід п р а в л я є  зн а ч е н н я  о с т а н н ь о г о  циклу*)

e n d _ i f  ;|

Рис.4.10. Лістинг програми для відправки запиту на читання 100 внутрішніх регістрів
з фіксацією часу трназакції.
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ЛАБОРАТОРНА РОБОТА № 6 (модуль 4).
Використання технології ОРС для зв’язку 8САБА+РЬС, 8САБА+8САБА.

ЧАСТИНА 1.

Тривалість: 2 акад. години (1 пара).
Мета: Навчитись користуватися технологією ОРС для зв’язку між
мікропроцесорними засобами автоматизації в гетерогенних системах (між 
пристроями різних виробників).

Лабораторна установка.
Лабораторна робота виконується на робочих місцях 2,3 (одна бригада), 4,5 

(друга бригада), 6,7 (третя бригада) та 9,10 (четверта бригада). Лабораторна 
установка для робочих місць 2 та 3 зображена на рис.6.1.
Апаратне забезпечення. Лабораторна 
установка складається з двох пар:

ПЛК Twido -  MODBUS RTU -  ПК
ПК між собою з’єднані за допомогою 
Ethernet з використанням комутатора 
(Switch).

Програмне забезпечення. На
комп’ютері використовується SCADA- 
програма VijeoCitect, OPC Сервер OFS 
(OPC Factory Server, вир. Шнейдер 
Електрик) з вбудованими драйверами 
зв’язку MODBUS RTU Master, тестова 
програма OFS Client (вир. Шнейдер 
Електрик).

Загальна постановка задачі. Цілі 
роботи:

- за допомогою тестової програми
OPC Клієнта перевірити основні механізми роботи з локальним та 
віддаленим ОРС Сервером;

- реалізувати поставлену задачу, оформлену у вигляді схеми інформаційних 
потоків, яка передбачає обмін даними між Сервером вводу/виводу SCADA 
VijeoCitect та ПЛК та між серверами VijeoCitect з використанням технології 
ОРС;

Деталізований опис постановки задачі. У
лабораторній роботі необхідно реалізувати задачу, 
показану на моделі (рис.6.2) та схемі (рис.6.3) 
інформаційних потоків (рис.3.2). Система повинна 
забезпечити обмін даними між PLC і SCADA 
(потоки 1,2,4) а також між двома SCADA (потік 3).
Параметри настройок програмно-технічних 
засобів відповідно до варіанту наведені в таб. 6.1.
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Дана система являється гомогенною, оскільки використовуються продукти 
одного виробника (Шнейдер Електрик). У таких системах зв’язок між засобами може 
проходити з використанням закритих але більш ефективних технологій. БСЛОЛ 
програма УуеоСіїесї 7 базується на кластерній системі серверів, яка дозволяє 
будувати мультиклієнтські та мультисерверні системи з використанням власних 
протоколів обміну. У даній лабораторній роботі для цих цілей використовується 
відкрита технологія ОРС БЛ2.0, яка не така ефективна в гомогенних системах ШЕ, 
але являється стандартом технології інтеграції в гетерогенних системах (системах з 
використанням засобів різних виробників).

7 7 ■ OPC DCOM ■

IP=192.168.9.3
LAN

PC2

Citect TOServerl
PLC3 Var1
PLC3 Var2

Г— PC2 Var

OPC Client

OPC Server (Schneider-Aut.OFS)
OFS Server

MODBUS RTU Master

COM1
■ MODBUS запити -

PLC3 Porti
Slave 3

4)
W1
W2

■7------7 - Ethernet

Рис.6 .3 .

IP=192.168.9.2
LAN

PC2

lOPC Server (Citect.OPCRemote) 
Citect TOServerl

У PLC2 Vari
PLC2 Var2
PC3 Var

OPC Client

I OPC Server (Schneider-Aut.OFS) I
OFS Server
MODBUS RTU Master

COM1
. MODBUS запити.

PLC2 Porti
Slave 2

D
W1
W2

Доступ до серверів вводу/виводу УуеоСіїесї надається через два типи ОРС 
Серверів: локальний ОРС з Рі^ГО -'С іїесї.О РС" та віддалений ОРС з
ProgID="Citect.OPCRemote". Таким чином при з’єднанні через ОРС з Сервером 
УуеоСіїесї на тому самому ПК використовується Рі^ГО -'С іїесї.О РС", а з Сервером 
на іншому ПК - Рі^ГО -'С іїесї.О РСКетоїе".

Таб.6.1.

Параметр робоче місце
2 3 4 5 7 8 9 10

по
ті

к 
1 Адреса Slave 2 3 4 5 7 8 9 10

бітова швидкість 19200 19200 19200 19200 9600 9600 9600 9600

паритет парн парн парн парн непар непар непар непар
стоп біт 1 1 1 1 1 1 1 1

змінні
PLC

W1 (%MWx) 12310 ООО40 3410 17610 3410 1110 6710 9510
W2 (%MWx) 210 310 410 510 710 810 910 1010

PC значення х в IP 
адресі 192.168.9.х

2 3 4 5 12 13 14 15

Ім’я вузла Comp2 Comp3 Comp4 Comp5 Comp 12 Comp 13 Comp 14 Comp 15
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Послідовність виконання роботи.

1) Зібрати лабораторну установку.___________________________________
УВАГА! Porti ПЛК Twido і COM-порт ПК не ізольовані, тому для безпечного з’єднання 

необхідно підключати перетворювачі при вимкнених ПЛК, з дозволу викладача.

2) За допомогою OFSConfiguration сконфігурувати OFS для реалізації поставленої
задачі. Вказати необхідність розширеного діагностичного режиму запуску 
сервера (OFS Server Settings-> Verbose).

3) Запустити на виконання програму OFS Клієнт, для перевірки локального серверу
"Schneider-Aut.OFS". Після завантаження OFS Сервера відкрити в ньому вікно 
Diagnostic Window. Проаналізувати останній запис у вікні, визначити Клієнта, 
що підключився останнім, та загальну кількість клієнтів. Результат занотуйте.

4) Повторити пункт 3 ще для одного OFS Клієнта. Після проведеного аналізу і
запису результатів, закрити його.

5) Створити одну групу з періодом відновлення 1000 мс, а другу 2000 мс. У кожній
групі створити по одному Item, який би відповідав відновленню змінної W1. 
Після створення проаналізувати, як відновлюються дані в різних групах. 
Проаналізувати Value, TimeStamp, Quality для всіх Item. Результат занотувати.

6) Вимкнути ПЛК, після чого проаналізувати Value, TimeStamp та Quality для всіх
Item в OPC Group. Результат занотувати. Після запису результатів включити 
ПЛК.

7) Створити проект в VijeoCitect, з двома змінними, що відповідають W1 та W2 на
PLC (потоки 1 та 4). Забезпечити їх відображення та можливість зміни значення 
на мнемосхемі. Перевірити роботу системи в режимі виконання (ран-тайм) 
VijeoCitect.

8) Запустити на виконання програму OFS Клієнт, для перевірки локального ОРС
Серверу "Citect.OPC". Створити групу та добавити із списку змінних змінну 
PLCx_Var2. Задати змінній довільне значення в OFS Клієнті та 
проконтролювати її зміну в ран-тайм системі VijeoCitect. Після вдалого 
результату закрити OFS Клієнт.

9) Повторити пункти 3-5 для віддаленого OFS Серверу (інше робоче місце бригади).
10) Повторити пункт 8 для віддаленого серверу вводу/виводу VijeoCitect (інше

робоче місце бригади).
11) Закінчити реалізацію поставленої задачі на рис.6.3.

Оформлення роботи.
До захисту готовляться всі занотовані результати з поясненнями.

Перевірка виконання роботи та питання до захисту.
Викладачем вибірково перевіряється виконання всіх пунктів роботи та 

занотовані результати. Кожен результат студент повинен пояснити. У випадку 
виникнення помилок або запитань щодо проведення певного пункту, цей пункт 
необхідно буде повторити.

1. Поясніть основні принципи функціонування технології ОРС. На якій 
технології міжпрограмного обміну вона базується?
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2. Назвіть специфікації стандарту ОРС, які функціонують на сьогоднішній 
день, та їх призначення. Яка специфікація використовувалась в даній 
лабораторній роботі?

3. Яку послідовність необхідно зробити, щоб забезпечити доступ в програмі 
ОРС-Клієнта до змінної в контролері через ОРС-Сервер?

4. Як визначається джерело даних в ОРС-Серверах та в OFS Сервері зокрема?
5. Як ідентифікуються дані OPC-Серверу програмою ОРС-Клієнта? Яким 

чином формуються ItemID для OFS-Серверу.
6. Як ОРС-Клієнт ідентифікує необхідний ОРС-Сервер? Яка програма може 

називатись ОРС-Клієнтом а яка ОРС-Сервером?
7. Чи може одна і та сама програма бути одночасно і ОРС-Клієнтом і ОРС- 

Сервером? Назвіть які програми ОРС-Клієнти та ОРС-Сервери 
використовувались в лабораторній роботі.

8. Розкажіть як відбувається доступ до даних через об’єкти OPC-Item. Чи 
може надаватися доступ ОРС-Клієнтам до одних і тих самих даних ОРС- 
Сервера? Чи можуть декілька ОРС-Клієнтів користуватися одним і тим 
самим OPC-Item?

9. Яка інформація про дані надається через об’єкт OPC-Item? Прокоментуйте 
це на прикладах пунктів 5 та 6 даної лабораторної роботи.

10. Розкажіть про призначення об’єктів ОРС-Group. Які групові операції для 
об’єктів OPC-Item проводяться через ОРС-Group? Прокоментуйте це на 
прикладі пункту 5.

11. Які способи читання з джерела даних доступні в ОРС-DA 2.0? Як вони 
функціонують? Яке з них на Вашу думку найбільш підходить до 
опитування даних процесу в засобах SCADA/HMI?

12. Які способи запису даних доступні в ОРС-DA 2.0? Як вони функціонують? 
Яке з них на Вашу думку найбільш підходить до супервізорної зміни даних 
в засобах SCADA/HMI?

13. Які вимоги ставляться до мережної системи для можливості зв’язку ОРС- 
Клієнта з віддаленим ОРС-Сервером?

14. Що додатково необхідно вказати в ОРС-Клієнті для ідентифікації 
віддаленого ОРС-Сервера, з яким необхідно з’єднатись? Прокоментуйте це 
на прикладі пунктів 9 та 10.

15. Розкажіть про область застосування ОРС-технології на прикладі даної 
лабораторної роботи.

Додаток 6.1. Робота з OFS Client.

Д6.1.1. Загальні положення. Програма OFS Client призначена для тестування 
роботи OPC DA Серверів, в тому числі OFS Server. Програма підтримує наступні 
функції:

1. роботу з локальними або віддаленими ОРС Серверами, які підтримують 
специфікацію OPC DA;

2. визначення переліку підтримуваних інтерфейсів об’єкту OPCServer та 
OPCGroup ;

3. створення OPC групи з вказаними ім’ям, часом відновлення, зоною 
нечутливості;
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4. доступ до властивостей ОРС груп, зокрема управління активацією групи 
(періодичне читання), управління підпискою (асинхронні операції);

5. створення OPC Item та зміна їх властивостей;
6. проведення асинхронних та синхронних операцій над OPC Item;
7. доступ до часових відміток зчитування/запису всіх змінних
Д6.1.2. З’єднання з ОРС-Сервером.
Після завантаження програми, необхідно вказати ОРС Сервер, з яким повинен 

зв’язатися OFS Client. У списку ProgID ОРС Серверів доступні тільки ті, які 
підтримують вказану версію специфікації над списком (при All -  сервери 
підтримують 1.0 і 2.0 одночасно). Вибраний ОРС Сервер висвітлюється в полі 
ProgID. У випадку з’єднання з віддаленим ОРС сервером, в полі Node додатково 
вказується назва віддаленого ПК або його IP (наприклад \\192.168.9.1 або \\COMP1).

Д6.1.3. Робота з ОРС-Group та OPC-Item.
Меню Group->NewGroup -  створення нової групи;
Меню Item->New -  створення нового OPCItem; в списку вибирається 

конкретний ItemID;
При створенні, ОРС Group по замовченню автоматично проводить періодичне 

читання з повідомленням. У цьому випадку, Item будуть відображати значення та 
властивості з періодом UpdateRate OPC групи.

В меню Group можна проводити групові синхронні/асинхронні операції над Item 
а також міняти властивості групи (Properties): активність(Active), режим
повідомлення(Notifications) і т.д.

Додаток 6.2. Настройка VijeoCitect на роботу з ОРС серверами.

Для конфігурування Citect/VijeoCitect як ОРС-клієнтів, для кожного ОРС- 
серверу створюється окремий Device, послідовність створення якого аналогічна як 
для інших типів пристроїв. Особливості конфігурування показані на рисунку.
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період відновлення в 
мілісекундах

адреса комп’ютера з 
ОРС-сервером 
(пишеться без \\)

I Ports [ RemoteOPC ] У 0 І.ХІ номер логічного 
порту

унікальний номер 
пристрою

Address. Schneider-Aut OF!

Add ] [ Replace Delete

I/O  D e v ice s  [  R em oteO PC  ]

Server Name □Server

Name Number

Frotoco JPU PORTI BÜARD1 vпа те

Memory

о m merit

Record: 1

ProgID Серверу 
ОРС

завжди = ОРС

Рис.6.4 Вигляд вікна конфігурації ОРС Серверу в VijeoCitect.
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ЛАБОРАТОРНА РОБОТА № 7 (модуль 4).
Використання відкритих технологій доступу до баз даних в комп’ютерно- 

інтегрованих системах управління.

Тривалість: 4 акад. години (2 пари).
Мета: Навчитись користуватися технологіями доступу до баз даних для їх 
використання при побудові комп’ютерно-інтегрованих систем управління.

Лабораторна установка.
Лабораторна робота виконується на робочих місцях 2,3 (перша бригада), 4,5 

(друга бригада), 7,8 (третя бригада) та 9,10 (четверта бригада). Лабораторна 
установка для робочих місць 2 та 3 зображена на рис.7.1. Комп’ютер РС1 
використовується для всіх робочих місць в якості технологічного сервера.

Рис.7.1. Лабораторна установка для першої бригади.

Апаратне забезпечення. Лабораторна установка складається з двох пар: ПЛК 
Twido -  MODBUS RTU -  ПК та ПК робочого місця 1 (РС1). ПК між собою з’єднані 
за допомогою Ethernet з використанням комутатора (Switch).

Програмне забезпечення. На комп’ютерах використовується SCADA-програма 
VijeoCitect (Шнейдер Електрик), Microsoft Excel, вбудований в ОС Windows XP 
Адміністратор ODBC, Microsoft® SQL Server™ Management Studio Express (SSMSE, 
Microsoft), на РС1 - Microsoft SQL Server 2000 (Microsoft).

Загальна постановка задачі. Цілі роботи:
- навчитись створювати БД для забезпечення ведення централізованого архіву;
- навчитись використовувати технології OLEDB та ODBC для доступу до 

джерел даних на прикладі SCADA VijeoCitect та Microsoft Excel;
- реалізувати поставлену задачу, оформлену у вигляді схеми інформаційних 

потоків, яка передбачає ведення централізованого архіву, та доступ до 
архівних даних з боку офісного прикладного забезпечення;

Деталізований опис постановки задачі. У лабораторній роботі необхідно 
реалізувати задачу, показану на моделі (рис.7.2) та схемі (рис.7.3) інформаційних 
потоків на прикладі варіанту для бригади 1. Система складається з трьох підсистем: 
підсистема 1, підсистема 2 та технологічний сервер.
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Функції: 1,3 -  збір та відображення технологічних 
параметрів витрат пари; 2,4 -  збір та обробка даних; 
5 -  ведення централізованого архіву; 6 -  розрахунок 
середніх витрат пари;
Інформаційні потоки: 1 -  витрати пари Б31, Б32 з 
період. 2с; 2 -  витрати пари Б21, Б22 -  з період. 2с; 3 
-  витрати пари Б31, Б32 з період. 10 с; 4 -  витрати 
пари Б21, Б22 з період. 10 с; 5 -  архівні Б21, Б31 за 
останні 5 хв з період. 1 хв.

Рис.7.2. Постановка задачі у вигляді графової моделі мережних інформаційних
потоків

Реалізацію системи умовно можна поділити на чотири етапи.
1. У SCADA VijeoCitect кожної підсистеми реалізувується зчитування значень 

витрат пари з використанням вбудованих драйверів Modbus RTU (потоки
1,2): F31,F32 з PLC3 (підсистема 2); F21, F22 з PLC2 (підсистема 1). Діапазон 
витрат (0-10000 м /год), періодичність зчитування 2 с;

2. З використанням середовища Microsoft® SQL Server™ Management Studio 
Express, на віддаленому вузлі технологічного серверу, що базується на 
Microsoft SQL Server, створюється база даних (DB1), таблиця Т2 для 
підсистеми 1, та таблиця Т3 для підсистеми 2, зі значеннями колонок 
відповідно F21, F22 та F31, F32. Таблиці необхідно спроектувати таким 
чином, щоб в одній з колонок зберігався час запису (див. додаток 7.1).

3. У SCADA VijeoCitect кожної підсистеми необхідно реалізувати архівування 
значень витрат (потоки 3,4) у відповідній таблиці технологічного серверу. 
Для ведення архіву використовується технологія ODBC та вбудована в 
VijeoCitect мова CiCode. Спочатку налаштовується ODBC DSN, який 
посилається на потрібну базу даних. У SCADA VijeoCitect створюється 
DEVICE з посиланням на потрібну таблицю джерела даних DSN (див. 
додаток 7.2). Створюється CiCode функція для добавлення запису в таблицю 
з плинними значеннями змінної. Для періодичності запису 10 с, в VijeoCitect 
створюється EVENT, який буде викликати функцію добавлення запису.

4. У програмі Microsoft Excel комп’ютера підсистеми 1, необхідно реалізувати 
зчитування архівних значень F21 та F31 за останні 5 хвилин (потік 5) та 
порівняння їх середніх значень у вигляді кругової діаграми. Періодичність 
вибірки -  1 хв. Доступ до архівних даних проводиться через механізми 
імпорту (див. додаток 7.4). Вибірка необхідних даних проводиться через SQL 
запити (див. додаток 7.3). Середнє значення розраховується вбудованими 
функціями Excel, порівняння середніх значень F21сер та F31 сер проводиться 
через кругову діаграму.
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Рис.7.3. Постановка задачі у вигляді схеми мережних інформаційних потоків

Таб.7.1.
Параметр бригада 1 бригада 2 бригада 3 бригада 4

підсист. 1 підсист. 2 підсист. 1 підсист. 2 підсист. 1 підсист. 2 підсист. 1 підсист. 2
робоче місце 2 3 4 5 7 8 9 10
Адр. Slave 2 3 4 5 7 8 9 10
бітова швидк. 19200 19200 19200 19200 9600 9600 9600 9600
паритет парн парн парн парн непар непар непар непар
стоп біт 1 1 1 1 1 1 1 1
змін.1 PLC W21

%MW123
W31

%MW68
W21

%MW34
W31

%MW176
W21

%MW34
W31

%MW11
W21

%MW67
W31

%MW95
змін.2 PLC W22

%MW124
W32

%MW69
W22

%MW35
W32

%MW177
W22

%MW35
W32

%MW12
W22

%MW68
W32

%MW96
назва БД,
користувач,
пароль

DB1,
користувач G1, 

пароль 1

DB2,
користувач G2, 

пароль 1

DB3,
користувач G3, 

пароль 1

DB4,
користувач G4, 

пароль 1

Послідовність виконання роботи.
1. Забезпечення читання змінних з ПЛК.

1.1) Зібрати лабораторну установку.__________________________________
УВАГА! Porti ПЛК Twido і COM-порт ПК не ізольовані, тому для безпечного з’єднання 

необхідно підключати перетворювачі при вимкнених ПЛК, з дозволу викладача.

1.2) У VijeoCitect реалізувати потоки 1 (підсистема 2) та 2 (підсистема 1). 
Результат перевірити в режимі виконання.

2. Створення БД та таблиць на технологічному сервері.
2.1) На одному з робочих місць бригади (ПК підсистеми 1 або 2) запустити на 
виконання Microsoft® SQL Server™ Management Studio Express (SSMSE). 
З’єднатися с сервером: ім’я COMP1, схема аутентифікації - "SQL Server", 
користувач та пароль - відповідно до варіанту; опцію заповнити пароль не 
виставляти .
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2.2) Перевірити наявність бази даних відповідно до варіанту (наприклад для 
бригади 1 -  DB1). У випадку наявності такої -  видалити її.
2.3) Створити базу даних, відповідно до варіанту.
2.4) Створити таблицю T2 з наступними властивостями:
Стовпчик 1: Ім’я = F21, тип = char(10), дозволити значення null;
Стовпчик 2: Ім’я = F22, тип = char(10), дозволити значення null;
Стовпчик 3: Ім’я = DateTime, тип = datetime, дозволити значення null, Значення 

або прив’язка по замовченню -  GetDate();
Вигляд конфігураційного вікна зафіксувати скриншотом.
2.5) Створити таблицю T3 з наступними властивостями:
Стовпчик 1: Ім’я = F31, тип = char(10), дозволити значення null;
Стовпчик 2: Ім’я = F32, тип = char(10), дозволити значення null;
Стовпчик 3: Ім’я = DateTime, тип = datetime, дозволити значення null, Значення 

або прив’язка по замовченню -  GetDate();
Вигляд конфігураційного вікна зафіксувати скриншотом.

3. Архівування даних в VijeoCitect.
3.1) Сконфігурувати джерело даних ODBC з ім’ям DSN=CtTAB, що по 
замовченню повинна посилатися на потрібну базу даних, відповідно до варіанту.

-  "Пуск"->"Настройка"->"ПанельУправления"->"Администрирование"-> 
"Источники данных (ODBC)";

-  "Системный DSN", "Добавить";
-  вибрати драйвер SQL Server;
-  налаштувати драйвер на відповідне джерело даних:

■ ім’я (DSN-ім’я): CtTab;
■ аутентифікація: SQL;
■ користувач та пароль, відповідно до варінату;

-  перевірити з’єднання за допомогою тестової кнопки;
3.2) У VijeoCitect створити DEVICE (System->Devices) типу SQL з іменем 
"Archive", зв’язаний з ODBC, створеним в п 3.1 (DSN=CtTAB). Вказати ім’я 
таблиці відповідно до варіанту. Вказати формат таблиці, відповідно до варіанту за 
прикладом:

{F21,10}{F22,10}
Вигляд конфігураційного вікна зафіксувати скриншотом.
3.3) У VijeoCitect створити новий файл Cicode (Активний Проект->Cicode Files- 
>Create a new Cicode Page) з довільною назвою і записати в ньому функцію з 
іменем FnWriteToSQL за прикладом, наведеним в додатку 7.2. Зберегти файл.
3.4) У VijeoCitect створити генератор подій EVENT (System->Events) для виклику 
функції FnWriteToSQL 1 раз/10с (відповідно до параметрів інформаційного 
потоку). У параметрах новоствореного EVENT задати:

Name = EventWriteDB 
Action =FnWriteToSQL()
Period = 00:00:10

Вигляд конфігураційного вікна зафіксувати скриншотом.
3.5) Скомпілювати проект VijeoCitect. Після вдалої компіляції необхідно 
активувати генератор подій для системи виконання. У Citect Exlporer запустити 
Computer Setup Wizard (Tools->ComputerSetupWizard), вибрати режим 
CustomSetup, у вікні Network Setup вибрати "No Networking", у вікні EventsSetup
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виставити опцію "Enable Events on This Computer" та "EventWriteDB". Запустити 
виконавчу систему VijeoCitect.
3.6) Спостерігати за роботою системи протягом 1 хв, у випадку з’явлення 
повідомлення "Не вдається відкрити базу даних" перевірити всі підпункти пунктів 
2 та 3, та досягнути вдалого результату.
3.7) Не зупиняючи виконавчу систему VijeoCitect, переглянути зміст таблиць Т2 
та Т3 в базі даних технологічного серверу, використовуючи SSMSE. Якщо даних 
в таблицях немає перевірити всі підпункти пунктів 2 та 3, та досягнути вдалого 
результату.
3.8) Періодично оновлюючи таблицю (наприклад через "Выполнить код SQL") 
дочекатися, коли з’являться записи в таблицях Т2 та Т3 старіше за 5 хвилин. 
Вигляд таблиць Т2 та Т3 зафіксувати скриншотом.
3.9) У SSMSE для таблиці Т2 показати область SQL-кода. Відредагувати запит 
змінивши його на вибірку полів F21 та DateTime таблиці Т2 за останні 5 хвилин. 
Вигляд таблиці Т2 та SQL-запиту зафіксувати скриншотом.
3.10) У SSMSE для таблиці Т3 показати область SQL-кода. Записати запит на 
вибірку полів F31 та DateTime таблиці Т3 за останні 5 хвилин. Вигляд таблиці Т3 
та SQL-запиту зафіксувати скриншотом.

4. Реалізація вибірки архівних даних в Excel.
4.1) На РС підсистеми 1 завантажити Excel. Імпортувати дані з таблиць T2 та Т3 
використовуючи OLE DB. У властивостях зовнішніх даних "Изменить запрос", 
визначіть рядок підключення, тип команди та текст команди. Результат 
зафіксуйте скриншотом та занотуйте. У властивостях діапазону зовнішніх даних 
визначіть фонове обновлення екрану кожну хвилину.
4.2) Повторити пункт 4.1 для таблиці Т3 але в інших комірках.
4.3) У параметрах зовнішніх даних "Изменить запрос" змініть тип команди на 
SQL, в полі тексту команди введіть запит як в пункті 3.9. Результат зафіксуйте 
скриншотом.
4.4) Повторити пункт 4.3 для таблиці зовнішніх даних з таблиці Т3, з запитом 
аналогічним як в пункті 3.10.
4.5) Для перетворення текстових даних в числові в сусідніх колонках напроти 
полів зі значеннями F21 та F31 використати функцію Excel "ЗНАЧЕН", яка 
знаходиться в бібліотеці категорії "текстовые". Новостворені колонки назвати 
F 2H  та F3H . На основі створених даних побудувати діаграму типу "График". 
Результат зафіксуйте скриншотом.
4.6) Для підрахунку середнього арифметичного по кожній із колонок F 2 ^  та 
F 3H  використати функцію Excel "СРЗНАЧ", яка знаходиться в бібліотеці 
категорії "Статистические". На основі середніх даних побудувати кругову 
діаграму (необхідні дані вибрати Crtrl).

Оформлення роботи.
До захисту готовляться всі зафіксовані сриншоти та занотовані результати з 

поясненнями.

Перевірка виконання роботи та питання до захисту.
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Викладачем вибірково перевіряється виконання всіх пунктів роботи та 
занотовані результати. Кожен результат студент повинен пояснити. У випадку 
виникнення помилок або запитань щодо проведення певного пункту, цей пункт 
необхідно буде повторити.

1. Які програмні засоби і навіщо доступаються до архівних даних? Який тип 
СУБД використовувався в даній лабораторній роботі в якості джерела даних? 
Які програмні засоби в даній лобораторній роботі доступалися до даного 
джерела? Які відкриті технології доступу до баз даних при цьому 
використовувалися?

2. Як вирішується питання стандартизації інтерфейсу до СУБД через 
використання мови SQL? Що таке діалект SQL, який діалект 
використовувався в СУБД в даній лабораторній роботі? Які особливості 
СУБД були використані в лабораторній роботі?

3. Поясніть синтаксис оператору вибірки SELECT? Де і навіщо в даній
лабораторній роботі використовувався даний оператор? Поясніть
використання оператору SELECT на основі занотованих результатів.

4. На яких технологіях базується ODBC. Як ідентифікується джерело даних в 
ODBC? Поясніть всю послідовність створення DSN, яку Ви проводили в 
лабораторній роботі.

5. Наведіть послідовність операцій, яку необхідно зробити користувачеві для 
вказівки джерела даних програмі клієнту ODBC на прикладі підключення 
його в VijeoCitect.

6. Поясніть призначення об’єктів Connection (Connection String) та Command в 
технології ADO/OLE DB? Яким чином формується Рядок Підключення? 
Прокоментуйте дані та інші поля на прикладі пункту 4.3 даної лабораторної 
роботи.

7. Чи можна доступитись до джерел даних ODBC через інтерфейс OLE DB та 
ADO? Обґрунтуйте свою відповідь.

8. Поясніть пункти 3.3 та 3.4 даної лабораторної роботи. Поясніть програму 
написану на CiCode.
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Додаток 7.1. Робота з Microsoft SQL Server Management Studio Express
(SSMSE).

Д7.1.1. Загальні положення. Середовище Microsoft® SQL Server™ Management 
Studio Express (SSMSE) надає графічний інтерфейс для управління більшістю 
реляційних СУБД SQL Server версії 2005 та нижче. Середовище SSMSE можна 
безкоштовно завантажити з офіційного сайту Microsoft.

У середовищі SSMSE всі операції з базами даних можна проводити з 
використанням як графічних засобів так і SQL запитів.

Д7.1.2. З’єднання з необхідним Сервером. По замовченню ярлик для SSMSE 
знаходиться в "Пуск->Программы->Microsoft SQL Server 2005-> SQL Server 
Management Studio Express ". Підключення до необхідного екземпляру SQL Server 
проводиться наступним чином:

"меню Файл->Подключить к обозревателю объектов... "
У діалоговому вікні вказати необхідне ім’я екземпляру Серверу, тип 

аутентифікації ("проверка подлинности"), ім’я користувача та пароль (рис.7.4). При 
необхідності зв’язку з віддаленим SQL Сервером його ім’я вказується в форматі:

ім'я_комп'ютера\ім'я_екземпляру_сервера 
У даній лабораторній роботі для підключення до MS SQL Server 2000, достатньо 

вказати тільки ім’я к о м п ’ютера, тобто СОМР1.

Рис.7.4. Вікно вибору сервера

Д7.1.3. Добавлення та знищення бази даних. Добавлення бази даних (БД) в 
графічному редакторі ББЫЗБ можна зробити через контекстне меню "Базы данных" 
вибраного екземпляру Серверу. У діалоговому вікні (рис.7.5) достатньо вказати ім’я 
новостворюваної БД і нажати "Ок", база даних створиться з параметрами по 
замовченню, що задовольняє умовам даної лабораторної роботи.

Видалення БД проводиться в її контекстному меню. Враховуючи, що 
користувачам в даній лабораторній роботі не надані адміністративні права на 
знищення журналів, у діалоговому вікні перед знищенням необхідно зняти опцію 
"Удалить журналы резервного копирования и восстановления базы данных", інакше 
БД не буде видалена.
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Рис.7.5. Вікно створення БД
Д7.1.4. Створення та видалення таблиць в базі даних. У ББЫЗБ Таблиці 
створюються в контекстному меню бази даних "Таблицы". При створенні 
викликається конструктор таблиць (рис. 7.6) в якому задається структура таблиці: 
стовпці та при необхідності їх зв’язки. Збереження структури таблиці проводиться в 
меню "Файл->Сохранить Таблицу". Конструктор таблиці також можна викликати 
вже після створення таблиці, викликавши в її контекстному меню команду 
"Изменить".

Таблица - с!Ьо.Т2 С во д ка

Имя столбца Тип д ан н ы х Р а зреш и т,,,

F21 cha r(10 ) 0

F22 cha r(10 ) 0

►  і DateTim e da te tim e 0

□

С вой ства  столб цов

0 І :  Z“  '1
□ (Общие)

(Имя)

З начение или пр и в я зка  по ум олчанию

Р азреш ить зна чени я  null

Тип д а н н ы х

Рис.7.6. Вікно констнуктона таблиць 
Знищення таблиці проводиться через її контекстне меню.

DateTime

(g e td a te ())

Да
da te tim e

Д7.1.5. Вибірка та модифікація даних в 88М8Е. Перегляд та редагування 
записів таблиць графічними засобами проводиться в конструкторі запитів, через 
контекстне меню "Открыть таблицу" (рис.7.7). При цьому в головному меню 
з’являється пункт "Конструктор запросов", в якому в підменю "Область" можна 
вибрати різні типи відображення (Області). Так вибірку потрібних даних можна 
проводити за допомогою БОЬ запитів в області БОЬ-кода. Перевірку БОЬ-коду та 
запуск його на виконання можна проводити через відповідні команди меню 
"Конструктора запросов".
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Рис.7.7. Вікно конструктора запитів з активованою областю SOL-коду

Додаток 7.2. Робота VijeoCitect з базами даних SQL.

Д7.2.1. Загальні положення. У VijeoCitect є декілька механізмів роботи з 
джерелами даних типу SQL. Один з найпростіших -  це використання спеціальних 
об’єктів для роботи з зовнішніми пристроями -  DEVICE разом з CiCode командами.

Об’єкти DEVICE створюються в Project Editor в розділі System->Devices. Одним 
із типів DEVICE є ODBC джерело даних типу таблиця. VijeoCitect підтримує роботу 
тільки з символьним (текстовим) типом даних. Базу даних та таблицю в ній 
необхідно створити перед її використанням в Device.

Д7.2.2. Налаштування параметрів DEVICE для роботи з SQL джерелами 
даних. Для роботи з DEVICE типу SQL необхідно сконфігурувати наступні поля 
(рис.7.8):

Name -  довільна назва пристрою, наприклад DevDB
Format -  формат таблиці, тобто назва та ширина в символах колонок таблиці. 

Наприклад, формат - {Name,16}{Water,8}{Sugar,8}{Flour,8}{Salt,8}{Yeast,8}{Milk,8} 
буде визначати таблицю наступного вигляду:

Name Water Sugar F our Salt Yeast Milk

Header -  для SQL типу пристрою вказується рядок підключення, наприклад:
DSN=ExmplDataBase; UID=G1; PWD=1 

вказує на ім’я DSN "ExmplDataBase", ім’я користувача (UID) рівним "G1", 
пароль (PWD) рівним "1".

FileName -  ім’я таблиці в базі даних, до якої необхідно підключитись 
Type -  для SQL типу пристрою вибирається SQL_DEV 
NoFiles -  кількість файлів, для SQL типу пристрою дорівнює -1 
Поля Time, Period, Prpcess, ClusterName, Comment в даній лабораторній роботі 

необхідно залишити порожніми.
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Рис.7.8. Вікно конфігурації Device в ViieoCitect

Д7.2.3. Добавлення записів в джерело даних DEVICE з використанням 
CiCode. Добавлення нових записів в CiCode проводиться через функції DevAppend, 
зміна значень полів запису через функцію DevSetField. Робота даних функцій з 
конкретним Device проводиться через дескриптор (handle), який повертається 
функцією DevOpen.

Роботу функцій розглянемо через функцію користувача FnWriteToSQL, яка 
заносить новий запис в DEVICE з ім’ям Archive, та полями F21 та F22, які вміщують 
значення витрат.

FUNCTION FnWriteToSQL()
INT hDev; //дескриптор пристрою
ErrSet(1); //обробку помилок робить програма користувача

//відкрити DEVICE з іменем Archive, який буде посилатись на таблицю T2
hDev=DevOpen("Archive",0);

IF hDev = -1 THEN //якщо помилка відкриття
MessageOH  вдається відкрити базу даних","Не вдається відкрити базу даних",0);

ELSE //якщо помилки немає
//добавити новий запис в таблицю 
DevAppend(hDev);

//записати в поле F21 значення змінної PLC2_F21 
DevSetField(hDev, "F21", RealToStr(PLC2_F21,5,2));
//де F21 -  назва колонки в таблиці бази данних
//PLC2_F21 -  назва змінної в VijeoCitect, значення якої треба записувати

//записати в поле F22 значення змінної PLC2_F22 
DevSetField(hDev, "F22", RealToStr(PLC2_F22,5,2));
//де F22 -  назва колонки в таблиці бази данних
//PLC2_F22 -  назва змінної в ViieoCitect, значення якої треба записувати

END
DevClose(hDev);
END
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Додаток 7.3. Використання SQL запитів.

Д7.3.1. SQL запити на вибірку. Загальний вигляд SQL-запита на вибірку 
рядків(записів) з таблиць:

SELECT списокполівчерезкому
FROM таблицяБД
WHERE умовавибіркизаписів

Наприклад, наступний запит повертає всі поля таблиці Т2, які задовольняють 
умові більшості поля DateTime за '2006-09-19 00:00:00':

SELECT *
FROM T2
WHERE T2.DateTime>'2006-09-19 00:00:00'
Д7.3.2. Використання вбудованих функцій MS SQL Server. MS SQL Server 

дає можливість створювати власні та використовувати існуючі функції (Function) та 
збережені процедури (Stored Procedure). В лабораторній роботі в запитах SQL 
використовуються вбудовані функції SQL Server для роботи із датою та часом: 
DATEADD та GETDATE.

DATEADD (частина, кількість, датачас) -  добавляє до вказаної дати та часу 
вказану кількість частин (секунд, хвилин, годин і т.д.)

GETDATE() -  повертає плинне значення дати та часу. Формат часових даних -  
datetime, маже мати вигляд ’yyyy-mm-dd hh:mi:ss’, наприклад: '2006-10-10 12:36:48'. 
Параметр частина в функціях задається відповідними буквами, тобто "уууу"-рік , 
"mm" -  місяць, "dd" -  хвилини, "hh"- години, "mi" -  хвилини, "ss" -  секунди.

Наприклад, наступний запит повертає поля F21 та DateTime таблиці Т2 за 
останні 5 хвилин, при умові що в полі DateTime зберігається дата та час збереження.

SELECT F21, DateTime
FROM T2
WHERE T2.DateTime> DATEADD ("mi",-5,GETDATE())

Додаток 7.4. Імпорт даних в Excel.

У таблиці Excel можна імпортувати зовнішні дані, наприклад із баз даних, 
використовуючи інтерфейс OLE DB або ODBC.

В лабораторній роботі використовується імпорт даних із баз даних та файлів 
використовуючи інтерфейс OLE DB. Імпорт даних через OLE DB проводиться 
наступним чином: " Данные->Импорт внешних данных->Импортировать данные...". 
При виборі цього способу імпорту необхідно вказати джерело даних, настройки 
якого збережені в файлі, або створити нове Підключення за допомогою кнопки 
"Создать". Для повної настройки джерела даних в меню майстра Підключення треба 
вибрати пункт "Дополнительно", після чого вибрати необхідного провайдера даних 
та налаштувати параметри Підключення. Після вставки даних в таблицю Excel 
можна змінити Рядок Підключення, Тип та Текст Команди через контекстне меню 
вставлених даних "Изменить запрос". Наприклад можна змінити тип запиту на SQL, 
і вписати SQL-запит в поле "Текст команды"
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ЛАБОРАТОРНА РОБОТА № 9 (модуль 3).

Конфігурування мережі CANOpen, використання сервісів PDO та SDO. 
Використання профілю CiA-402 для управління пристроями PDS.

ЧАСТИНА 1.
Тривалість: 2 акад. години (1 пара).
Мета: Навчитись створювати конфігурацію мережі СЛКОреи відповідно до 
завдання.

Лабораторна установка.
Лабораторна робота виконується на робочих місцях 2-5 двома бригадами, інші дві 
бригади в цей час виконують другу частину лабораторної роботи №9. Лабораторна 
установка зображена на рис.9.1, для частини 1 використовується тільки в якості 
наглядного прикладу.
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*Кольори проводів позначені цифрами: 1 (СЛМ_И) -  білий; 2 (СЛМ_Ь) -  синій; 3 (вМО) -  
чорний; 4 (У+) - червоний; 5 -  не підключений

Рис.9.1. Схема мережних з’єднань до лабораторної установки.
Апаратне забезпечення. В таблиці наведена специфікація мережних засобів. Опис 
роботи засобів та способи їх підключення наведені в додатках 9.1 -  9.3.
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Специфікація мережних засобів
№ Позна­

чення
Назва Тип Кіль­

кість
Фірма

1 PLC1 ПЛК TSX Premium TSX 57204M 1 шт. SE
2 RIO1

(KK2)
Острів віддаленого вводу/виводу Advantys 
STB, з комунікаційним модулем CANOpen 
AdvabtysSTB

STB NCO 2212 1 шт. -//-

3 PDS1 Частотний перетворювач Altivar71 для 
управління асинхронним двигуном

ATV71H037M3 1 шт. -//-

4 KK1 Комунікаційна PCMCIA карта CANOpen для 
TSX Micro/Premium

TSX CPP110 1 шт. -//-

5 КМ1,К
М2

Магістральний кабель (подвійна екранована 
вита пара для CANOpen)

TSX CAN 
CA100

40 м -//-

6 ЮШ,К
М4

Кабель для підключення пристроїв по 
CANOpen, з обох боків 9-пінова SUB-D 
розетка, 1 м.

TSX CAN 
CADD1

1 шт. -//-

7 KM5 Кабель для підключення пристроїв по 
CANOpen, з обох боків RJ-45 вилка, 1м

TSX CAN 
CARR1

1 шт. -//-.

8 K m ,
КП2

Коробка підключення пристроїв до 
магістральної шини CANOpen з 4-ма портами 
типу 9-пінова SUB-D вилка

TSX CAN 
TDM4

1 шт. -//-

9 КП3 Коробка підключення частотних 
перетворювачів Altivar до магістраль-ної шини 
CANOpen, 3 порти RJ-45 розетка (2 -  CAN, 1 -  
Modbus RTU)

VW3 CAN TAP 
2

1 шт. -//-

Рис.9.2. Схема мережних інформаційних потоків до лабораторної роботи
Програмне забезпечення. Для створення конфігурації для PLC1 використовується 
UNITY PRO, для створення конфігурації для TSX CPP 110 використовується SyCon. 
Загальна постановка задачі. Ціль роботи -  створити конфігурацію мережі для TSX 
CPP 110 та PLC Premium відповідно до поставленої задачі, оформлену у вигляді 
схеми інформаційних потоків (рис 9.2) та варіанту. В даній роботі вважається, що 
пристрої RIO1 та PDS1 вже сконфігуровані.

Послідовність виконання роботи.
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1. Запустити SyCon та створити конфігурацію мережі відповідно до таблиці
Параметр робоче місце

2 1 3 4 5
*.EDS RIO1 STB NCO 2212
*.EDS PDS1 ATV 71 V2.6

Адреса RIO1 (N) 1 2 3 4
Адреса PDS1 (M) 2 3 4 5
бітова швидкість 1 Мбіт/с 500 Кбіт/с 250 Кбіт/с 100 Кбіт/с

періодичність
SYNC

100 мс 200 мс 250 мс 500 мс

управління RIO1 
при старті (Д9.4.3)

всі стадії активні всі стадії активні без NODE RESET 
та перевірки 

профілю

без конфігурації 
пристрою

управління PDS1 
при старті (Д9.4.3)

без NODE RESET без перевірки 
профілю

всі стадії активні всі стадії активні

протокол контролю 
за помилками

для всіх вузлів 
Node Guard

для всіх вузлів 
Heartbeat

для всіх вузлів 
Node Guard

для всіх вузлів 
Heartbeat

PL
C1

ТРЬС 1 %MW10 %MW20 %MW30 %MW40

ТРЬС 2 %MW11-%MW14 %MW21-%MW22 %MW31-%MW34 %MW41-%MW44

ТРЬС 3 %M W15 -%M W17 %M W 2 3 -%M W 2 5 %M W 3 5 -%M W 3 6 відсутній

ТРЬС 4 відсутній %MW50 %MW60 %%MW70

ТРЬС 5 %MW40 %MW51 %MW61-%MW62 %MW71-%MW72

тога

ТЯЮ_1 DI0-DI7 DI0-DI7 DI0-DI7 DI0-DI7

ТЯЮ_2 відсутній DO0-DO7 DO0-DO7 DO0-DO7

Об’єкт
Словника*

відсутній відсутній Index/SubInd=300
0/0

значення FF16

Index/SubInd=3001/0 
значення FF16

PD
S1

ТРББ_1 Status Word 6041/0 Control Effort Frequency Ref Status Word
Control Effort 6044/0 Status Word Status Word Control Effort
Frequency Ref 2002/4 Motor Current Frequency Ref
Motor Current 2002/5 Motor Torque Motor Current

ТРББ 2 Motor Torque 2002/6 Frequency Ref Mains Voltage відсутній
Mains Voltage 2002/8 Motor Current Motor Voltage
Motor Voltage 2002/9 Motor Torque

ТРББ_3 Control Word 6040/0 Target Velocity 6042/0 Control Word Target Velocity
Target Velocity Control Word

Об’єкт
Словника*

Index/SubInd=2000/13 
значення 10J6

Index/SubInd=2000/14 
значення 516

відсутній відсутній

П
ар

ам
ет

ри
 ін

 ф
ор

м.
 п

от
ок

ів

потік 1 синхронно через 
кожні 20 Об’єктів 

SYNC

при запиті RTR, 
через кожні 10 
циклів NMT- 

Ведучого

синхронно, при 
зміні значення

при запиті RTR, 
через кожні 15 
циклів NMT- 

Ведучого
потік 2 відсутній визначено профілем 

асинхронно через 
кожні 5 циклів 
NMT-Ведучого

синхронно при 
зміні значення

синхронно через 
кожні 20 Об’єктів 

SYNC

потік 3 при запиті RTR, через 
кожні 30 циклів NMT- 

Ведучого

визначено профілем 
пристрою, кожні 2 с

при запиті RTR, 
через кожні 20 
циклів NMT- 

Ведучого

визначено профілем 
пристрою, кожні 

500 мс

потік 3 а визначено профілем 
пристрою, кожні 500 

мс

синхронно через 
кожні 20 Об’єктів 

SYNC

визначено 
профілем 

пристрою, кожні 
1 с

відсутній

потік 4 визначено профілем 
асинхронно через 

кожні 10 циклів NMT- 
Ведучого

синхронно при зміні 
значення

синхронно через 
кожні 20 Об’єктів 

SYNC

асинхронно через 
кожні 10 циклів 
NMT-Ведучого
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* - додатковий Об’єкт Словника та його значення, який необхідно змінити при 
конфігурації NMT-Ведучим в NMT-Веденому вузлі

2. Порівняти SDO таблицю з наведеними значеннями в таблиці Т9.1 (відповідно до
варіанту), якщо вона не співпадає повернутися до пункту 1.

3. Зберегти файл конфігурації на диску під назвою "lab9.co".
4. Завантажити UNITY PRO та створити конфігурацію ПЛК TSX 572634M (OS2.0), з

комунікаційною картою TSX CCP 110. Налаштувати параметри комунікаційної
карти відповідно до варіанту. Параметри конфігурації записати в таблицю Т9.2.

Оформлення роботи.
До захисту готовляться дві таблиці Т9.1 та Т9.2 (див. додаток 9.5) відповідно до 

варіанту. В полі коментар таблиці Т9.1 вписується призначення запису та пояснення 
числового значення.

Перевірка виконання роботи та питання до захисту.
Викладачем перевіряється виконання поставленого завдання шляхом звірки 

значень отриманої студентом SDO Table та таблиці Т9.1, а також будь який із 
пунктів завдання по вибору. Захист роботи проводиться по Т9.1 та Т9.2. Студент 
повинен пояснити призначення всіх полів, та їх значення.

1. На яких стандартах на фізичному рівні базується CANOpen і які додаткові 
вимоги ставляться на цьому рівні? Наведіть основні характеристики CANOpen 
на фізичному рівні: спосіб передачі бітів, топологія, правила термінування, 
максимальна довжина ліній зв’язку та відгалужень, бітова швидкість, 
максимальна кількість пристроїв. Як це реалізовано в лабораторній роботі.

2. Розкажіть про призначення Словнику Об’єктів. Яким чином визначається 
місце розміщення Об’єктів в Словнику?

3. Перерахуйте комунікаційні сервіси, які використовуються в CANOpen. 
Поясніть їх призначення. Які Комунікаційні Об’єкти використовуються для 
реал-тайм обміну невеликими обсягами даних процесу? Які Комунікаційні 
Об’єкти використовуються для обміну великими обсягами даних?

4. Що забезпечують функції сервісу PDO? Які комунікаційні Об’єкти 
використовуються для функціонування даного сервісу? Поясніть призначення 
T-PDO та R-PDO. Як забезпечується їх взаємний Зв’язок та зберігається 
інформація про нього?

5. Як забезпечується зв’язок даних T-PDO/R-PDO з Об’єктами Словнику? Як 
називається цей механізм? Де зберігаються настройки таких зв’язків?

6. Яке призначення NMT-сервісів? Яке призначення NMT-Ведучого в CANOpen 
та які функції він виконує? Поясніть різницю між NMT-Ведучим та Ведучим 
шини. Як ідентифікується конкретний вузол в CANOpen і для чого це 
потрібно?

7. Яким чином забезпечується зв’язок між Комунікаційними Об’єктами вузлів до 
їх функціонування в операційному режимі? Поясніть механізм розподілу 
Ідентифікаторів по замовченню. Яке правило наперед-визначеного статичного 
зв’язування PDO в мережі?
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8. Які режими ініціації обміну об’єктів PDO є в CANOpen? Поясніть їх 
функціонування? Як забезпечується синхронізація передачі PDO в чітко 
визначені моменти часу? Який вузол генерує синхронні об’єкти? Які 
комунікаційні режими передачі (Transmission Type) визначені в CANOpen? 
Прокоментуйте призначення кожного режиму. Де зберігається налаштування 
режиму для кожного PDO?

9. Яким чином в CANOpen вузол повідомляє про наявність помилки? Які сервіси 
використовуються для визначення станів NMT-Ведених та NMT-Ведучих 
вузлів на шині?

10. Які переваги дає профілювання пристроїв для використання їх в CANOpen? 
Які типи профілів пристроїв для CANOpen Ви можете назвати? Яким чином в 
Об’єкті Словнику вказується його приналежність до конкретного профілю?

ЧАСТИНА 2.

Тривалість: 2 акад. години (1 пара).
Мета: Навчитись користуватися сервісами РБО, ББО та управляти частотними 
перетворювачами по профілю СіА 402.

Лабораторна установка.
Лабораторна робота виконується на робочому місці 8 двома бригадами, інші дві 
бригади в цей час виконують першу частину лабораторної роботи №9. Лабораторна 
установка зображена на рис.9.1.
Апаратне забезпечення. В таблиці наведена специфікація мережних засобів. Опис 
роботи засобів та способи їх підключення наведені в додатках 9.1 -  9.3.

Рис.9.3. Схема мережних інформаційних потоків до лабораторної роботи
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Програмне забезпечення. Для створення конфігурації для PLC1 використовується
UNITY PRO, для створення конфігурації для TSX CPP 110 використовується SyCon.
Загальна постановка задачі. Цілі роботи: створити конфігурацію мережі для TSX
CPP 110 та PLC Premium відповідно до поставленої задачі, оформлену у вигляді
схеми інформаційних потоків (рис 9.3); перевірити функціонування сервісв PDO та
SDO; навчитись управляти частотним перетворювачем через сервіс CiA-402.

В даній роботі пристрої RIO1 та PDS1 вже сконфігуровані.

Послідовність виконання роботи.
1) Запустити на ПК8 SyCon та створити конфігурацію мережі відповідно до схеми 

інформаційних потоків, що зображена на рис.9.3 (за винятком потоків 5 та 6, які 
оформляються через сервіс SDO). Бітова швидкість -  1 Мбіт/с, профіль RIO1 -  
тільки дискретні входи та дискретні виходи. Всі інші параметри, що не вказані на 
схемі інформаційних потоків та не уточнені в задачі залишити по замовченню. 
Зберегти файл конфігурації на диску під назвою "lab9_2.co" але не закриваючи 
SyCon.

2) Завантажити UNITY PRO та створити конфігурацію ПЛК TSX 572634M (OS2.0), з 
комунікаційною картою TSX CPP 110. Налаштувати параметри комунікаційної 
карти відповідно до схеми інформаційних потоків та підключити файл "lab9_2.co" 
в режимі SyCon. Створити конфігурацію для Ethernet відповідно до лабораторної 
роботи №4 (частина 2), та прив'язати її до інтегрованого в процесорний модуль 
каналу Ethernet (інакше UNITY PRO не скомпілює проект).

3) Створити або імпортувати секцію з програмою та змінними (див. Д9.6). Для 
імпорту виділити в Project Browser в розділі Program->Tasks->Mast->Sections-> 
контекстне_меню->Import..., вказати файл PKIS9_SDO.XBD. Імпортувати змінні, 
для чого виділити в Project Browser в розділі Variables->контекстне_меню- 
>Import, вказати файл PKIS9_CAN.XSY. Після імпорту необхідно перевірити 
створення змінних в розділі Variables & FB instances.

Імпортувати таблицю анімацій, для чого виділити в Project Browser в розділі
Animation Tables->контекстне_меню->Import, вказати файл PKIS9_CAN.XTB.
Скомпілювати проект та завантажити його в контролер.
4) Завантажити із SyCon активну конфігурацію в карту TSX CPP110 (див. Д9.4.7). 

Після завантаження запустити ПЛК на виконання.
5) Необхідно перевірити роботу RIO1: стан індикаторів (CANRunn повинен 

світитися, CANERR не світитися); в таблиці анімацій послідовно змінювати 
змінні RIO1_Outputs.0 до RIO1_Outputs.5, при цьому слідкувати за індикаторами 
каналів модуля та змінними RIO1_Inputs.0... RIO1_Inputs.5. Якщо зворотній 
зв'язок присутній -  перейти до пункту 6, якщо ні -  до пункту 1.

6) Орієнтуючись на змінну стану частотного перетворювача (див. додаток 9.7) 
необхідно виставити задану частоту на 1500 об/хв. та запустити двигун. 
Перевірити індикатори на частотному перетворювачі та значення змінної дійсної 
швидкості.

7) Виставити задану частоту на 500 об/хв. Перевірити індикатори на частотному 
перетворювачі та значення змінної дійсної швидкості. Зупинити двигун.

8) Зчитати значення мінімальної частоти частотного перетворювача через сервіс 
SDO. Результат зчитування перевірити через змінну PARA. Виставити задану 
частоту рівною 0. Запустити двигун. Перевірити індикатори на частотному
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перетворювачі та значення змінної дійсної швидкості. Результати проаналізувати 
та записати.

9) Використовуючи сервіс SDO записати значення мінімальної частоти частотного 
перетворювача на 1 Гц більше ніж було до того, але більше 5. Результат 
зчитування перевірити через змінну PARA1. Виставити задану частоту рівною 0. 
Перевірити індикатори на частотному перетворювачі та значення змінної дійсної 
швидкості. Результати проаналізувати та записати.

10) Використовуючи сервіс SDO записати значення мінімальної частоти 
частотного перетворювача рівною 5 Гц. Зупинити двигун.

Оформлення роботи.
В оформлення роботи включається SDO-таблиця SyCon та копія сторінки 

конфігурації мережної карти TSX CPP 110.
Перевірка виконання роботи та питання до захисту.

Викладачем перевіряється виконання поставленого завдання шляхом перевірки 
пунктів 5-10. Студент повинен розуміти роботу прикладної програми, яка 
використовується в даній роботі, функціонування сервісів PDO, SDO та вміти 
пояснити автомат станів частотного перетворювача згідно профілю CiA-402.

1. В чому необхідність знання структури Словнику Об’єктів конкретного засобу? 
Який ресурс необхідно використати для її визначення? Прокоментуйте 
загальноприйнятий розподіл Індексів різних типів Об’єктів в Словнику.

2. Що забезпечують функції сервісу SDO? Які комунікаційні Об’єкти 
використовуються для функціонування даного сервісу? На якій моделі 
прикладного обміну базуються сервіси SDO?

3. Порівняйте функціонування PDO та SDO сервісів. В яких випадках 
використовуються одні та інші?

4. Яким чином забезпечується обмін даними за допомогою об’єктів SDO? Як дані 
SDO-об’єктів зв’язуються з даними Прикладних Об’єктів Словнику? Як 
забезпечується передача даних великого обсягу?

5. Яким чином реалізований сервіс SDO в контролерах TSX Premium? 
Прокоментуйте комунікаційні функції, що використовуються в UNITY PRO 
для читання Об’єктів Словника через сервіс SDO.

6. Розкажіть про наявні профілі пристроїв PDS та їх відображення на промислові 
мережі в стандартах МЕК 61800-7?

7. Поясніть відмінність поняття профілю PDS від промислової мережі, що 
підтримуються даним пристроєм. Чи визначає факт використання конкретної 
промислової мережі наявність конкретного профілю PDS та навпаки?

8. Прокоментуйте функціонування профілю CiA402 в контексті функціональних 
елементів. Які основні відмінності даної реалізації від стандартної МЕК 61800­
7-1?

9. Як реалізуються в CiA402 змінні COMMAND та STATUS, визначені в МЕК 
61800-7-1? З якими мережами використовується даний профіль?

10. Прокоментуйте схему функціонування автомату станів базових 
функціональних елементів для профілю CiA402.

11. Прокоментуйте схему функціонування операційної роботи приводу в режимі 
управління швидкістю для профілю CiA402.
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Додаток 9.1. Використання та конфігурування карти TSX CPP 110.

карти TSX CPP110 з 
відгалуженням

Д9.1.1. Загальні положення. Комунікаційна карта TSX CPP110 (формат 
PCMCIA III) призначена для підключення ПЛК TSX 
Premium та TSX Micro до мереж CAN та CANOpen.
Карта підтримує стандарт CANOpen - DS301 V4.01, а 
саме:

-  підтримує бітову швидкість до 1Мбіт/с;
-  може виконувати функції NMT-Ведучого;
-  дає можливість проводити динамічне PDO- 

Відображення та PDO-Зв’язування;
-  доступні функції "Heartbeat";
-  може бути SYNC-Producer;
-  Node-ID карти потрібен тільки для функцій 

"Heartbeat".
Карта також підтримує можливість 

безпосереднього обміну CAN-кадрами стандарту CAN 
V2.0B. Конфігурування карти проводиться утилітою 
SyCon >=V2.8 (див. додаток 9.4).

Д9.1.2. Підключення. Карта TSX CPP110 поставляється разом з кабелем 
відгалуження, який в кінці має коробку підключення з вбудованим 9-піновим SUB-D 
роз’ємом (рис. 9.4). Таке виконання дає можливість 
уніфікувати кабелі відгалуження. Підключення коробки 
TSX CPP110 до магістрального кабелю можна проводити 
з використанням аксесуарів сторонніх виробників 
(конектори, клеми, коробки), або через спеціальні 4-х 
портові коробки відгалуження SX CAN TDM4 (рис.9.5) з 
вбудованим термінатором лінії.

Д9.1.3. Методика конфігурування карти. Для 
створення конфігурації мережі для ПЛК TSX 
Micro/Premium, окрім програм PL7 PRO або Unity PRO, 
необхідне додаткове спеціалізоване ПЗ -  SyCon V>=2.8.
Порядок створення конфігурції наступний:

Рис.9.5. Коробка 
відгалуження TSX CAN 

TDM4 на 4 порти типу Sub- 
D 9-pin

1. Створюється проект конфігурації мережі на SyCon та 
записується на диск у вигляді файлу з роширенням *.СО;

2. Створюється конфігурація ПЛК TSX Premium, в якій для 1-го каналу 
процесорного модуля (або модуля SCY 21601) замовляється комунікаційна карта 
TSX CPP110;

3. Для комунікаційної карти вказується файл проекту мережі, створений за 
допомогою SyCon (рис. 9.6), налаштовуються діапазон змінних для відображення 
вхідних R-PDO та вихідних T-PDO комунікаційної карти.

Після конфігурування мережі та комунікаційної карти, конфігурація 
завантажується в ПЛК разом з проектом. Кількість конфігураційних даних для 
мережі CANOpen може бути дуже великою, що приведе до необхідності виділення 
значної пам’яті процесора. Тому передбачені два варіанти завантаження 
конфігураційних даних карти для TSX CPP110: "UNITY PRO" та "SyCon". 
Необхідний режим завантаження вибирається у вікні "Configuration load mode" (див.
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рис 9.6). У випадку вибору режиму "SyCon", завантаження конфігураційних даних 
карти TSX CPP110 необхідно проводити засобами SyCon (див. додаток 9.4). У 
випадку режиму "UNITY PRO" конфігураційні дані TSX CPP110 будуть зберігатися 
та змінюватися разом з даними проекту (конфігурація ПЛК, програма, тощо). Режим 
SyCon є сенс використовувати тільки для зменшення пам’яті, що виділяється для 
конфігураційних даних. В лабораторній роботі зажди вказуйте режим SyCon.

Рис.9.6. Конфігурація мережі в UNITY PRO.

Додаток 9.2. Використання та конфігурування Advantys STB NCO 2212.

Д9.2.1. Загальні положення. Advantys STB -  це 
сімейство наборної системи з модулів розподіленого 
вводу/виводу, живлення, інших типів модулів та 
пристроїв, які підключаються до промислової мережі, як 
один модульний пристрій. Таку систему також називають 
островом. Крім Advantys STB, Шнейдер Електрик 
пропонує острови Advantys OTB та Advantys FTB.

Підключення острову Advantys STB до промислової 
мережі проводиться через відповідний базовий мережний 
інтерфейсний модуль (NIM). Крім функцій обміну даними 
процесу через мережний порт, NIM також надає 
можливість конфігурування острову через додатковий 
порт CFG з використанням спеціального ПО -  Advantys 
Configuration Software. Крім того, CFG порт дає 
можливість підключення до острову засобів SCADA/HMI

Рис.9.7. Комунікаційний 
модуль STB NCO 2212 для 

мережі CANOpen
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по мережі Modbus RTU/ASCII. Використання порту CFG та Advantys Configuration 
Software в лабораторній роботі не розглядається.

Для мережі CANOpen використовується NIM модуль STB NCO 2212 (рис.9.7). 
Даний модуль характеризується такими властивостями:

-  профіль по замовченню DSP-401;
-  максимальна кількість Об’єктів Словнику: 32 T-PDO та 32 R-PDO; 512 

device-specific Об’єктів та 512 manufacturer-specific Об’єктів;
-  розподіл Об’єктів в Словнику та PDO-Відображення по замовченню 

відповідно до DSP-401: R-PDO-1 для 64 Дискретних виходів, R-PDO-2 
(додатково R-PDO-3 та R-PDO-4) для 12 аналогових виходів, T-PDO-1 для 
64 дискретних входів, T-PDO-2 (додатково T-PDO-3 та T-PDO-4) для 12 
аналогових входів;

-  бітова швидкість до 1 Мбіт/с;
Д9.2.2. Підключення. Підключення модуля STB NCO 2212 до магістрального 

кабелю виконується через 9-піновий SUB-D 
конектор, що стандартизований CANOpen. В 
якості коробки відгалуження можна 
використати TSX CAN TDM4.

Д9.2.3. Налаштування швидкості та 
адреси. Налаштування швидкості та адреси 
для NCO 2212 проводиться за допомогою 
вбудованих перемикачів (рис.9.8). Для 
налаштування бітової швидкості, перед 
увімкненням живлення засобу, нижній 
перемикач переключають в позицію BAUD 
RATE а верхній -  в позицію потрібної 
швидкості: 0 (10 кБіт/с), 1 (20 кбіт/с), 2 (50 кбіт/с), 3 (125 кбіт/с), 4 (250 кбіт/с), 5 (500 
кбіт/с), 6 (800 кбіт/с), 7 (1 Мбіт/с). Після включення живлення, Advantys запам’ятає 
вказану швидкість.

Адреса пристрою (1-127) задається комбінацією позицій обох перемикачів: 
верхній -  десятки, нижній -  одиниці.

Д9.2.4. Об’єкти словнику та PDO-Відображення. Розподіл Об’єктів 
Словнику в області Device-Profile Area проводиться згідно профілю DSP-401:
-  Індекс 6000і6: дискретні входи згруповані 8-бітними блоками; Під-Індекси 1-32 

(20і6) відповідають за номер 8-бітного блоку; дискретні входи рахуються зліва- 
направо по їх розміщенню в острові;

-  Індекс 620016: дискретні виходи згруповані 8-бітними блоками; Під-Індекси 1-32 
(2016) відповідають за номер 8-бітного блоку; дискретні виходи рахуються зліва- 
направо по їх розміщенню в острові;

-  Індекс 640116: 16-бітні аналогові входи; Під-Індекси 1-32 (2016) відповідають за 
номер каналу аналогового входу; аналогові входи рахуються зліва-направо по їх 
розміщенню в острові;

-  Індекс 641116: 16-бітні аналогові виходи; Під-Індекси 1-32 (2016) відповідають за 
номер каналу аналогового виходу; аналогові виходи рахуються зліва-направо по 
їх розміщенню в острові;

PDO-Відображення по замовченню, відповідає мінімальним вимогам профілю 
DSP-401 для 2-х R-PDO та 2-х T-PDO, а також додатково включає по 2 R-PDO та 2

Рис.9.8. Налаштування адреси та 
бітової швидкості для Advantys STB.
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Т-РБО. Таким чином Відображення та комунікаційні параметри РБО по 
замовченню, має наступний вигляд:____________________________________________

PDO Відображення та комунікаційні параметри PDO
R-PDO-1 Об’єкти Індекс 6200, Під-індекси 1...8 (64 дискретних виходів), асинхронно
R-PDO-2 Об’єкти Індекс 6411, Під-індекси 1 . 4  (4 16-бітових аналогових виходів), асинхронно
R-PDO-3 Об’єкти Індекс 6411, Під-індекси 5 . 8  (4 16-бітових аналогових виходів), асинхронно
R-PDO-4 Об’єкти Індекс 6411, Під-індекси 9 .1 2  (4 16-бітових аналогових виходів), асинхронно
T-PDO-1 Об’єкти Індекс 6000, Під-індекси 1 . 8  (64 дискретних входів), передача асинхронно по зміні значення
T-PDO-2 Об’єкти Індекс 6401, Під-індекси 1 . 4  (4 16-бітових аналогових входів), асинхронно по зміні значення
T-PDO-3 Об’єкти Індекс 6401, Під-індекси 5 . 8  (4 16-бітових аналогових входів), асинхронно по зміні значення
T-PDO-4 Об’єкти Індекс 6401, Під-індекси 9 .1 2  (4 16-бітових аналогових входів), асинхронно по зміні значення

Додаток 9.3. Використання та конфігурування CANOpen для Altivar ATV 71.

Д9.3.1. Загальні положення. Частотні 
перетворювачі (надалі ЧПР) Altivar 71 мають 
вбудований порт Modbus/CANOpen з типом роз’єму 
RJ-45. Даний порт призначений для конфігурування 
ATV 71, управління та контролю його роботи як по 
мережі Modbus RTU так і по CANOpen. Режим роботи 
порту визначається конфігураційними настройками 
ЧПР, які проводяться через спеціальну панель, що 
прикріплена на його фронтальній стороні. В режимі 
CANOpen ЧПР підтримує профіль DSP-402 (профіль 
для пристроїв PDS), який крім розподілу Об’єктів в 
словнику та PDO-Відображення по замовченню, 
визначає послідовність управління самим PDS. 
Детальніше управління пристроями PDS з 
використанням профілю DSP-402 розглядається в 
додатку 9.7.

ATV71

VW3 CAN 
TAP 2

Рис.9.9. Підключення 
ATV71 до коробки 

відгалуження VW3 CAN 
TAP 2

Д9.3.2. Підключення. Один із варіантів 
підключення до магістральної шини проводиться з 
використанням спеціальної коробки відгалуження 
VW3 CAN TAP 2 (рис.9.9). Ця коробка має 2 порти RJ- 
45 для підключення частотних перетворювача (ATV1 
та ATV2) за допомогою кабелю VW3 CA RR 1 та порт для підключення ПК 
(PowerSuite). Останній дозволяє в режимі роботи системи по Modbus RTU 
налаштовувати частотні перетворювачі за допомогою спеціального 
конфігураційного забезпечення PowerSuite (в лабораторній роботі дане ПЗ не 
використовується). Крім того, дана коробка має вбудований термінатор лінії.
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Д9.3.3. Налаштування частотного перетворювача для роботи з CANOpen.
Конфігурування частотного перетворювача може проводитись з використанням 
панелі настройки, параметри якої відображені в таблиці:________________________
1.DriveMenu -> 1.9.Communication [CANopen address] адреса вузла
-> CANopen [CANopen bit rate] бітова швидкість
1.DriveMenu -> 1.6.COMMAND -> [Profile] профіль управління PDS
CANopen [Ref. 1 channel] джерело завдання швидкості/частоти (для завдання 

частоти з мережі CANOpen, повинен бути вибраний 
рівним "CANOpen"), додатково див. Д9.7

[Cmd channel 1] настройка 1-го каналу управління на джерело 
команди управління (для управління PDS з CANOpen 
повинен бути вибраний рівним "CANOpen"), 
додатково див. Д9.7

[Cmd switching] перемикач каналів управління (для настройки каналу 
1 виставляється в режим "chn1 active"), додатково 
див. Д9.7

Додаток 9.4. Робота з SyCon.
Д9.4.1. Загальні положення. Програмний пакет SyCon (від компанії Hilscher) 
призначений для конфігурування промислових мереж PROFIBUS, InterBus, 
CANOpen, DeviceNet, ControlNet, SDS, AS-Interface і т.д. пристроїв Hilscher. За 
допомогою цієї програми також конфігуруються комунікаційні модулі та карти 
PROFIBUS, InterBus та CANOpen для TSX Micro/Premium від Шнейдер Електрик.

В лабораторній роботі SyCon використовується для конфігурування CANOpen 
карти TSX CPP110. Створення проекту та його завантаження в CPP110 має наступну 
послідовність:
1) В SyCon створюється проект (File->New) з вибором мережі CANOpen.
2) Добавляються потрібні *.EDS файли для пристроїв (File->Copy EDS), якщо вони 

відсутні в бібліотеці SyCon (в лабораторній роботі всі необхідні пристрої вже є в 
бібліотеці);

3) В конфігурації шини вставляється вузол NMT Ведучого (Insert->Master-> вибрати 
TSX CPP 110, нажати Add), виставляють необхідну адресу (Node ID) та назву 
(Description).

4) В конфігурації шини вставляються необхідні вузли NMT-Ведених (Insert->Node-> 
вибрати місце вставки-> лівий клік -> вибрати необхідний пристрій, нажати Add), 
виставляють необхідну адресу (Node ID) та назву (Description).

5) Для NMT-Ведених вузлів конфігуруються PDO (див. Д9.4.2).
6) Для NMT-Ведених вузлів конфігурується Node BOOT-UP, тобто поведінка NMT- 

Ведучого з вибраним вузлом при його включенні (див. Д9.4.3).
7) Для NMT-Ведених вузлів конфігуруються параметри контролю за помилками 

(Error Control); (див. Д9.4.4).
8) Для NMT-Ведених вузлів, при необхідності, конфігуруються значення Об’єктів 

Словнику, які необхідно змінити при старті. (див. Д9.4.5).
9) Конфгурується NMT-Ведучий та загальні параметри роботи шини. (див. Д9.4.6).
10) Створена конфігурація зберігається на диску (для підключення до проекту 

UNITY PRO) та завантажується в карту TSX CPP 110 через ПЛК (див. Д9.4.7).
Д9.4.2. Конфігурування PDO. Виклик конфігураційного вікна (рис.9.10) для 
конфігурування NMT-Ведених вузлів проводиться по подвійному кліку по його 
зображенню.
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Node Configuration

Node STB NCO 2212 Node ID (address) ■

Description |Node1 Configuration E rror
Control Protocol

File name STBNC02212EDS
1* Activate node in actual configuration Emergency COB-ID [Î23
W Automatic COB-ID allocation in accordance with Profile 301 Nodeguard COB-ID 11793

| Device Profile I 401 J Device type J Analog Output, Analog Input, Digital Output, Digital Input

GK
Cancel

Node BootUp

OPC Objects

Object
Configuration

Predefined Process Data Objects (PDOs) from EDS file
Obj.ldx. |PD0 name ! Enable
1400 RxPDOl Communication Parameter F a
1401 RxPD02 Communication Parameter F
1402 RxPD03 Communication Parameter F
1403 RxPDO 4 Communication Parameter F
1800 TxPDOl Communication Parameter F
1801 T xPD02 Communication Parameter ________________F |v

Actual node
|1 / STB NCO 2212 3

PDO mapping method 
|DS301 V4 3]

Add to configured PD Os

Configured PD Os

PDO name jSymbolic Name ICOB-ID II Type llAddr. I Len. 0 Type |0 Addr. O Len. A

RxPDOl PDOJ40C 513 QB 0 S ?
RxPD02 PDO J  401 769 QB 4 8
RxPD03 PDO J  402 1025 QB 8 8
RxPDO 4 PDO J  403 1281 QB 12 8
TxPDOl PDOJ800 385 ІЄ 0 8
TxPD02 PDO J  801 541 IB 4 8
TxPD03 PDO J  802 887 IB 8 S
TxPD04 PDO 1803 1153 IB 12- 8 V

PDO Contents Mapping...

PDO Characteristics..

Define new Receive PDO..

Define new Transmit PDO..

Delete configured PDO

Symbolic Names..

Зис.9.10. Вигляд вікна конфігурації NMT-Веденого вузла в SyCon.
Зміна профілю пристрою проводиться через кнопку "Device Profile" а 

уточнення типу через "Device Type".
По замовченню NMT-Ведучий обмінюється з NMT-Веденим. Однак можлива 

конфігурація, коли NMT - 
Ведений не приймає участь 
в обміні PDO з даним NMT- 
Веденим, а тільки 
конфігурує та управляє цим 
вузлом. Участь даного вузла 
в обміні з NMT-Ведучим 
конфігурується опцією 
"Activate node in actual 
configuration".

По замовченню всі
PDO
пов’язані з 
Ведучими 
визначеній 
ідентифікації

NMT-Ведених 
PDO NMT- 

по наперед 
схемі

тобто всі PDO

Рис.9.11. Вигляд вікна настройки PDO-Відображення.

визначені COB-ID, на які 
ручним та автоматичним

отримують наперед 
налаштований NMT-Ведучий. Переключення між 
завданням COB-ID для PDO виставляється в "Automatic COB-ID alloaction in 
accordance with Profile 301" (рис.9.10).

Список наперед визначених PDO відображається у вікні для NMT-Веденого 
доступний у вікні "Predefined PDOs from EDS file", а їх активація/деактивація 
проводиться опцією "Enable".
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Активні для обміну PDO відображаються в списку "Configured PDOs". 
Подвійний клік по вибраним активним PDO (або кнопка PDO Contents Mapping...) 
приводить до виклику вікна настройки PDO-Відображення (рис.9.11.). Доступні для 
PDO-Відображення Об’єкти Словнику показуються у списку "Mapable Objects from 
EDS file", подвійний клік по якому (або команда "Appened Object") добавляє його в 
список Відображених об’єктів даного PDO. Перелік Відображених на PDO Об’єктів 
вказаний у списку "Mapped Object dictionary".

Вікно налаштування комунікаційних параметрів обміну PDO викликається 
кнопкою "PDO Characteristics" (рис.9.10). Для R-PDO (рис.9.12) та T-PDO (рис.9.13) 
вікно налаштування комунікаційних параметрів відрізняється.

Рис.9.12. Вигляд вікна настройки характеристики Я-РРО.
Налаштування комунікаційних параметрів обміну Я-РРО для КМТ-Веденого 

це по суті налаштування відповідного йому Т-РРО для КМТ-Ведучого. В наступній 
таблиці наведені комунікаційні параметри для Я-РРО.

____________________ _______________________Комунікаційні параметри для Я-РРО.
Transmiss 
ion Type

Тип ініціації передачі PDO NMT-Ведучим

Node shall use a synchronization 
message to actuate the received PDO 0 PDO буде передаватись ациклічно при події визначеній в 

"Communication counter CANOpen Master", але тільки в момент 
отримання Об’єкту SYNC

Node shall use every X received 
synchronization message to actuate the 
received PDO

1-240 (X) PDO передаються синхронно з періодом, який визначається 
кількістю Об’єктів SYNC між передачами, вказану в значенні X 
(тип PDO).

Actuate the received PDO when data 
has changed (manufacturer specific) 254 момент відправки в мережу PDO не залежить від появи Об’єкту 

SYNC, і ініціюється подією визначеною в "Communication 
counter CANOpen Master"

Actuate the received PDO when data 
has changed (event triggered) 255 момент відправки в мережу PDO не залежить від появи Об’єкту 

SYNC і визначається профілем пристрою

Внизу вікна настройки (рис.9.12) в "Communication counter CANOpen Master" 
вказується подія ініціації обміну для ациклічних операцій:

-  Each time when data has changed -  кожен раз при зміні значення;
-  Every Y Master cycle interval -  кожні Y циклів NMT-Ведучого (час, що 

потрібний для внутрішньої обробки та оновлення значень всіх PDO)
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Р и с .9 .1 3 . В и г л я д  в ік н а  н а с т р о й к и  х а р а к т е р и с т и к и  T -P D O .

Налаштування комунікаційних параметрів обміну Т-РРО проводиться згідно 
наступної таблиці.
____________________ _________ ______________Комунікаційні параметри для Т-РРО

Transmission
Type

Тип ініціації передачі T-PDO NMT-Веденим

Node shall use a synchronization 
message as trigger to send the transmit 
PDO acyclically

0 PDO буде передаватись ациклічно при зміні значення, але 
тільки в момент отримання Об’єкту SYNC

Node has to send the transmit PDO at 
every (X) received synchronization 
message

1-240 (X) PDO передаються синхронно з періодом, який визначається 
кількістю Об’єктів SYNC між передачами, вказану в значенні 
X (тип PDO).

Node shall use a synchronization 
message as trigger to send the transmit 
PDO when previously remote requested 
by the master

252 в момент отримання Об’єкту SYNC вхідні дані T-PDO будуть 
оцифровані і збережені в T-PDO, а відправлений T-PDO 
відбудеться в момент отримання запиту Дистанційного Кадру 
(RTR)

Node shall send the transmit PDO when 
remote requested 253 T-PDO відновляється і відправляється при отриманні 

Дистанційного Кадру (RTR)
Transmission event of transmit PDO 
fully node manufacturer specific 254 момент відправки в мережу PDO не залежить від появи 

Об’єкту SYNC і визначається виробником пристрою
Transmission event of transmit PDO 
defined in the device profile of the node 255 момент відправки в мережу PDO не залежить від появи 

Об’єкту SYNC і визначається профілем пристрою

Для Т-PDO типу 254 та 255 можна визначити інтервал часу між відправками T- 
PDO. Цей параметр доступний не для всіх типів пристроїв і настроюється в області 
"Communication Timer Node" в полі "Event timer" (рис.9.13). Враховуючи, що 
Відображені Об’єкти на PDO типів 254 та 255 можуть оновлюватися дуже часто, 
передача PDO з високим пріоритетом може витіснити інші PDO. Для запобігання 
цього ефекту в області "Communication Timer Node" визначене поле "Inhibit Time" 
(Час Заборони), яке вказує на мінімальний час між двома передачами даного PDO.

Інтервал відправки Дистанційного Кадру (RTR) NMT-Ведучим для T-PDO 
типів 252 та 253 настроюється в полі "Remote Request CANopen Master".

Перелік всіх PDO на шині доступний через меню "View->ID Table" або "View- 
>Address Table".
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Д9.4.3. Конфігурування поведінки NMT-Веденого.

Рис.9.14. Вікно налаштування управління NMT-Ведучим 
NMT-Веденим при старті .

N o d e  R e s e t при активній опції, при старті NMT-Ведучого, він відправляє 
даному вузлу команду Node Reset

C h e c k  N o d e  T y p e  a n d  P ro file при активній опції, NMT-Ведучий порівнює дійсний профіль 
пристрою з вказаним в конфігурації, якщо вони не співпадуть 
буде згенерована помилка параметризації

C o n f ig u ra t io n  G u a rd in g  P ro to c o l при активній опції, NMT-Ведучий записує в пристрій параметри 
NodeGuard та Life-Time

C o n f ig u ra t io n  S Y N C  C O B -ID при активній опції, NMT-Ведучий записує в пристрій значення 
COB-ID об’єкту SYNC

C o n f ig u ra t io n  E M C Y  C O B -ID при активній опції, NMT-Ведучий записує в пристрій значення 
COB-ID об’єкту EMCY

C o n f ig u ra t io n  d o w n lo a d  o f  o b je c ts при активній опції, NMT-Ведучий записує в пристрій значення 
конфігураційних Об’єктів для PDO-обміну

S ta r t  N o d e при активній опції NMT-Ведучий відправляє команду Start для 
переводу його в операційний режим

In it ia te  P D O  d a ta при активній опції NMT-Ведучий проводить обмін даними PDO 
з даним вузлом
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Д9.4.4. Конфігурування параметрів контролю за помилками NMT-
Веденого.

Параметри
контролю за помилками 
NMT-Веденого 
конфігуруються у
відповідному вікні, через 
кнопку "Configuration 
Error Control Protocol" 
(рис.9.10). В залежності 
від можливостей вузла 
вибирається один з двох 
протоколів Node Guard 
або Heartbeat (рис.9.15).

Рис.9.15. Вікно налаштування параметрів контролю за
помилками.

Д9.4.5. Конфігурація початкових значень Об’єктів Словнику через сервіс
SDO. Об’єкти Словнику, які необхідно змінити при старті вузла, можна продивитись 
та змінити шляхом виклику вікна "Object Configuration" відповідною кнопкою у вікні 
конфігурації вузла (рис.9.10). У вікні Object Configuration (рис.9.16) в списку 
"Predefined supported Objects in the EDS file" знаходяться доступні Об’єкти Словнику 
відповідно до підключеного EDS файлу. Перелік Об’єктів, що будуть змінюватися 
при BootUp процедурі запуску вузла сервісом SDO, та їх значень вказуються у 
списку "Configured Objects automatically written while Node startup sequence". Там 
розмішуються ті
Об’єкти, які призначені 
для конфігурування PDO 
(відмічені PDO Dialog), а 
також туди можна 
добавити будь який 
інший Об’єкт, значення 
якого може бути 
змінений (доступ
Read/Write).

Перелік всіх
Об’єктів на шині які 
змінюються при старті за 
допомогою SDO
доступний через меню 
"View->SDO Table".

Рис.9.16. Вікно налаштування початкових значень Об’єктів 
Словнику через SDO.

Д9.4.6. Конфігурація загальних параметрів роботи шини. Вікно конфігурації 
загальних параметрів роботи шини викликається в меню "Settings->Bus Parameter" 
при активному курсорі на зображенні NMT-Ведучого. В цьому вікні (рис.9.17) 
настроюється бітова швидкість, поведінка NMT-Ведучого при виявленні помилки 
NMT-Веденого (зупинка комунікаційного обміну при виявленні помилки на будь
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якому вузлі), COB-ID ідентифікатор та частота появи об’єкту SYNC, активація 
Heartbeat та його настройки.

Д9.4.7. Завантаження конфігурації
Завантаження конфігурації SyCon в 
комунікаційну карту проводиться 
через ПЛК. В лабораторній роботі 
зв’язок з ПЛК проводиться через 
драйвер UNITELWAY. Для вибору 
та налаштування цієї комунікації 
необхідно в меню Settings->Device 
Assigment вибрати XWAY, далі 
вказати драйвер UNTLW01 і 
нажати Ок для підтвердження.
Для відправки даних в карту 
вибирається Online->Download. 
Контролер при цьому повинен 
знаходитись в стані STOP.

в карту TSX CPP 110 через ПЛК.

Рис.9.17. Вікно налаштування загальний 
параметрів роботи шини.

Додаток 9.5. Таблиці для оформлення частини 1 лабораторної роботи.
Таблиця T9.1.SDO Table

Варіант 1 (робоче місце 2).
No
de
ID

Obj. Idx Sub.
Idx

Parameter CurValue
(HEX)

коментар

1005 0 COB-ID Sync 80
1006 0 Communication Cycle 

Period
64

1 1800 1 COB-ID 181
2 Transmission type 14
3 Inhibit time 0

1A00 0 Number of mapped objects 1
1 8bit Input Block No. 1 60000108

2 1400 1 COB-ID 202
2 Transmission type FF

1600 0 Number of mapped objects 1
1 Controlword 60400010

1800 1 COB-ID 182
2 Transmission type FD
3 Inhibit time 0
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5 Event timer 0
1801 1 COB-ID 282

2 Transmission type FF
3 Inhibit time 12C
5 Event timer 1F4

1A00 0 Number of mapped objects 4
1 Statusword 60410010
2 Control Effort 60440010
3 Frequency ref. 20020410
4 Motor current 20020510

1A01 0 Number of mapped objects 3
1 Motor torque 20020610
2 Mains voltage 20020810
3 Motor voltage 20020910

2000 13 VMAX 10
Варіант 2 (робоче місце 3).

1005 0 COB-ID Sync 80
1006 0 Communication Cycle 

Period
С8

2 1400 1 COB-ID 202
2 Transmission type FF

1600 0 Number of mapped objects 1
1 8bit Output Block No. 1 62000108

1800 1 COB-ID 182
2 Transmission type FD
3 Inhibit time 0

1A00 0 Number of mapped objects 1
1 8bit Input Block No. 1 60000108

1017 0 Producer Heartbeat Time C8
1016 1 Consumer Heartbeat Time 7F012C
3000 0 1 byte special output object 

No. 1
FF

3 1016 1 Consumer Heartbeat Time 7F012C
1017 0 Producer Heartbeat Time C8
1400 1 COB-ID 203

2 Transmission type 0
1600 0 Number of mapped objects 1

1 Target Velocity 60420010
1800 1 COB-ID 183

2 Transmission type FF
3 Inhibit time 12C
5 Event timer 7D0

1801 1 COB-ID 283
2 Transmission type 14
3 Inhibit time 0
5 Event timer 0

1A00 0 Number of mapped objects 2
1 Statusword 60410010
2 Control Effort 60440010

1A01 0 Number of mapped objects 3
1 Frequency ref. 20020410
2 Motor current 20020510
3 Motor torque 20020610

2000 14 FMAX 5
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Варіант 3 (робоче місце 4).
1005 0 COB-ID Sync 80
1006 0 Communication Cycle 

Period
FA

3 1400 1 COB-ID 203
2 Transmission type 0

1600 0 Number of mapped objects 1
1 8bit Output Block No. 1 62000108

1800 1 COB-ID 183
2 Transmission type 0
3 Inhibit time 0

1A00 0 Number of mapped objects 1
1 8bit Input Block No. 1 60000108

3001 0 1 byte special output object 
No. 2

FF

4 1400 1 COB-ID 204
2 Transmission type 14

1600 0 Number of mapped objects 2
1 Controlword 60400010
2 Target Velocity 60420010

1800 1 COB-ID 184
2 Transmission type FD
3 Inhibit time 0
5 Event timer 0

1801 1 COB-ID 284
2 Transmission type FF
3 Inhibit time 12C
5 Event timer 3E8

1A00 0 Number of mapped objects 4
1 Frequency ref. 20020410
2 Statusword 60410010
3 Motor current 20020510
4 Motor torque 20020610

1A01 0 Number of mapped objects 2
1 Main Voltage 20020810
2 Motor Voltage 20020910

Варіант 4 (робоче місце 5).
1005 0 COB-ID Sync 80
1006 0 Communication Cycle 

Period
1F4

4 1016 1 Consumer Heartbeat Time 7F012C
1400 1 COB-ID 204

2 Transmission type 14
1600 0 Number of mapped objects 1

1 8bit Output Block No. 1 62000108
1800 1 COB-ID 184

2 Transmission type FD
3 Inhibit time 0

1A00 0 Number of mapped objects 1
1 8bit Input Block No. 1 60000108

1017 0 Producer Heartbeat Time C8
5 1016 1 Consumer Heartbeat Time 7F012C

1017 0 Producer Heartbeat Time C8
1400 1 COB-ID 205

2 Transmission type 0
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1600 0 Number of mapped objects 2
1 Target Velocity 60420010
2 Controlword 60400010

1800 1 COB-ID 185
2 Transmission type FF
3 Inhibit time 12C
5 Event timer 1F4

1A00 0 Number of mapped objects 4
1 Statusword 60410010
2 Control Effort 60440010
3 Frequency ref. 20020410
4 Motor current 20020510

Таблиця Т9.2.Параметри настройки області пам’яті для для обміну PDO в TSX
Premium.

Параметр Значення для Inputs Значення для Outputs
Index of 1st %MW
Nb. of words (%MW)

Додаток 9.6. Використання в прикладній програмі ПЛК Prem ium  сервісів SDO. 
Д9.6.1. Загальні положення. Сервіси SDO в TSX Premium доступні через 
використання функцій читання/запису READ_VAR та WRITE_VAR. Функції описані 
в додатках до лабораторної роботи №3, тут розглянемо тільки особливості їх 
використання для SDO.

Д9.6.2. Використання ADDR. Для формування адреси в функціях READ_VAR та 
WRITE_VAR використовується функція ADDR, де формат поля адреси має 
наступний вигляд:

’O.m.l.SYS’
, де m -  номер процесорного модуля в шасі (0 або 1).

Д9.6.3. Використання READ_VAR. Для зчитування Об’єктів Словнику через сервіс 
SDO в TSX Premium використовується функція READ_VAR з наступним 
синтаксисом в форматі ST:

READ VAR(Address, 'SDO', index:subindex, NodeID, Management Param, 
Receiving Array);
Address ARRAY [0.. 5] OFINT Адреса КМТ-ведучого на РСМСІА карті ТБХ 

СРР110, яка задається функцією АОБЯ 
(див.Д.9.6.1)

index:subindex DINT адреса Об’єкту в Словнику, в молодшому слові -  
Індекс, в старшому -  Під індекс, наприклад 
16#00010002 вказує на Об’єкт з Індексом 000216 та 
Підіндексом 000116

NodeID INT адреса вузла на САМОреп, до якого йде звернення
Management_Param ARRAY [0.. 3] OFINT Таблиця управління обміном (див.Д.4.1.6)

Receiving Array ARRAY [n... m] OF 
INT

Масив, який вміщує значення прочитаних змінних
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Д9.6.4. Використання WRITE_VAR. Для запису Об’єктів Словнику через сервіс 
SDO в TSX Premium використовується функція WRITE_VAR з наступним 
синтаксисом в форматі ST:

WRITE VAR(Address, 'SDO', index : subindex, NodeID, Data to Write, 
Management Param);
Address ARRAY [0.. 5] OFINT Адреса КМТ-ведучого на РСМСІА карті ТБХ 

СРР110, яка задається функцією АОБЯ 
(див.Д.9.6.1)

index:subindex DINT адреса Об’єкту в Словнику, в молодшому слові -  
Індекс, в старшому -  Під індекс, наприклад 
16#00010002 вказує на Об’єкт з Індексом 000216 та 
Підіндексом 000116

NodeID INT адреса вузла на САМОреп, до якого йде звернення
Data_to_Write ARRAY [n... m] OF 

INT
Масив, який вміщує значення даних, які треба 
записати

Management_Param ARRAY [0.. 3] OFINT Таблиця управління обміном (див.Д.4.1.6)

Перед викликом функції WRITE_VAR в останнє слово таблиці 
Management_Param необхідно записати кількість байт, які треба передати через SDO.

Д9.6.5. Використання WRITE_VAR. Варіант програми для читання та 
запису значень об’єктів через сервіс SDO. Приклад програми для читання та 
запису через SDO наведений на рис.9.18. Дискретні змінні READ_SDO та 
WRITE_SDO використовуються для ініціювання відповідно зчитування та запису, 
після чого значення цих змінних обнуляються. Перед викликом функції 
WRITE_VAR в третє (останнє) слово таблиці що управляє обміном (PARA1[3]) 
записується кількість байт що передаються -  два байта (ціле значення).

В лабораторній роботі сервіс SDO використовується для зчитування та запису 
конфігураційної настройки частотного перетворювача, яка відповідає за мінімальну 
частоту обертання (Index=200116, SubIndex=616). Дане значення зберігається в змінній 
ПЛК PDS_LowSpeed.
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Рис.9.18. Прикладна програма для зчитування та запису SDO.

Додаток 9.7. Управління частотними перетворювачами з використанням
профілю CiA-402.

Поведінка приводу PDS згідно профілю CiA-402 залежить від 
функціонального профілю пристрою. В лабораторній роботі використовується 
профіль управління швидкістю. Згідно цього профілю автомат станів частотного 
перетворювача має вигляд, як на рис.9.19.
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Рис.9.19. Автомат станів управління ЧПР по профілю управління швидкістю згідно
СіА 402.
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Лабораторні роботи №5 "Використання шини UniTelway" та №8 
"Використання Ethernet UNI-TE TCP/IP" призначені для факультативного вивчення 
за бажанням студентів. Протоколи робіт в електронному вигляді доступні на сервері 
кафедри інтегрованих автоматизованих систем управління в аудиторії А-532.
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